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Welcome to Philips
HeartStart Configure

Use Philips HeartStart Configure (HeartStart Configure) to configure your HeartStart
FR3, HeartStart FRx, and HeartStart HS1 defibrillators. This software helps you
change your defibrillator settings to support your medical director's response
protocol.

The user guide and the help system both provide instructions for performing common
configuration tasks. Use the table of contents to access topics. You can also use a
full-text search for topics, and view and print instructions.

You can access the user guide in two ways:

• In the Helpmenu, select HeartStart Configure User Guide.
• In theWindows Start menu, click All Programs, click Philips HeartStart

Configure 3.0, and then click User Guide.

Indications for Use
HeartStart Configure enables an administrator to configure a HeartStart FR3,
HeartStart FRx, or HeartStart HS1 defibrillator based on amedical director’s desired
protocol for response to a sudden cardiac arrest emergency. Configuration settings
for HeartStart FR3 are changed via Bluetooth or data card, whereas configuration
settings for HeartStart HS1 and HeartStart FRx are changed via infrared port.
Current configurations are retrieved from, modified, and transmitted back to the
AEDs. Configuration settings can be saved to a computer for future use or for use on
other AEDs.
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Typographical Conventions
The Philips HeartStart Configure User Guide uses the following conventions to help
identify information.

Conventions Used for Example

Bold Menu options, buttons, field
names, and list box names.

Click Import on the File
menu.

Input Text needed for input. Can
be alphanumeric. Sentences
that contain text might not
include end punctuation.

In the Configuration Name
field, type Modified FR3
2005 configuration

Italic Manual names. Instructions for
Administrator's Guide.

Screen
messages

Text designed to distinguish
defibrillator voice prompts
and HeartStart FR3 screen
messages from general text.

The defibrillator voice prompt
announces Administration

Press the center soft key (soft
key #2). The screen message
reads Ready for Data
Transfer

Upper case File extension types. The configuration is exported
as an XML file.

Lower-case
italics

Specific filenames. Name the configuration file
sample.xml.

A yellow box with a triangular caution icon and exclamationmark identifies
circumstances that can result in data corruption or information loss.

A blue box with a note icon contains usage information.

1 -Welcome to Philips HeartStart Configure
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A green box with a light bulb tip icon contains information to help you complete
a task.

Using Online Help
In the online help system, you can search for information using the full-text search
feature, the glossary, or an index.

Use these four methods to access online help in HeartStart Configure:

• Press the F1 key to open online help for the selected feature.

• Click the Help tab to show and hide help that is related to the feature you are
using. This online help pane displays to the right of the workspace.

• Click the help button on the toolbar.

• In the Helpmenu, select HeartStart Configure Help.

1 -Welcome to Philips HeartStart Configure
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2

Navigating this Guide
You can use the Table of Contents to locate information quickly. This document is
organized to help you find instructions to complete your defibrillator configuration
tasks.

This user guide is organized as follows:

• Use the overview section to install and use the software.

This section includes the following topics:

• Installing HeartStart Configure
• Activating the software
• Introducing HeartStart Configure
• Understanding How to Use HeartStart Configure

• Use the Changing Defibrillator Settings section to retrieve, modify, and send a
configuration to a defibrillator.

This section includes the following topics:

• Working with HeartStart FR3Defibrillators
• Working with HeartStart FRx Defibrillators
• Working with HeartStart HS1Defibrillators

• Use theWorking with Configurations section to save configurations for reuse,
transfer configuration settings to other users, and customize the way that
configurations display in the software.

This section includes the following topics:

• Managing Configurations
• Transferring Configurations
• Displaying Information

• Use the Contacting Customer Support section to resolve product software
issues.

• Use theWorking with the System Log section to troubleshoot software issues
and view system information.

• Use the appendixes to look up resource and reference information:
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• Appendix A . Describes how to obtain technical support.
• Appendix B provides details on each configuration parameter and its choice

of settings.
• Appendix C explains the voicemessages youmay hear while transferring a

configuration or customizing defibrillator settings.
• Appendix D lists System Logmessages. Use the System Log tomonitor

system performance or troubleshoot HeartStart Configure activity.
• The glossary lists terms that are used throughout the user guide and online

Help system.
• Use the Index to look up topics when reading the user guide. When you are

using online Help on your computer, you can click the link to open the
associated topic.

2 - Navigating this Guide
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Installing HeartStart
Configure

This topic describes how to install Philips HeartStart Configure software, identify the
system requirements, use the installation CD-ROM, start the software, and uninstall
HeartStart Configure from your computer.

HeartStart Configure is shipped with a CD and two printedmaterials: the Quick
ReferenceGuide, and a Proof of Purchase Certificate.

• The CD contains the HeartStart Configure software, the user guide, and a
ReadMe file.

• The Proof of Purchase Certificate contains the product serial number you will
need to activate the software.

• TheQuick ReferenceGuide contains the system requirements and installation
instructions.

Use the CD to install HeartStart Configure on your computer. Ensure that your
computer meets the recommended system requirements to install and run this
software.

Once you insert the CD into your computer, the installation wizard automatically
runs and prompts you to install the software. In certain cases, you will need to
manually start the setup program to run the installation. For more information, see
Using the Installation CD-ROM on page.15.

Youmust activate your software the first time you use it. You can do this either by
Internet or by email. The preferred activationmethod is by Internet, since there is no
waiting period. However, if you need to activate your software using email, see
Activating the Software by Email on page.18.

13
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System Requirements
These tables describe theminimum requirements to run HeartStart Configure.

Software Requirements

Component Requirements

Operating system Microsoft® Windows XP™ Professional, or Microsoft®
Windows 7™ Professional (32- or 64-bit)

Windows security Use standard Microsoft Windows security features to
manage user access

Hardware Requirements

Component Requirements

Processor speed Minimum: 1 GHZ x86 or x64 processor

Display Minimum: 1024 x 768

Recommended: 1280 x 1024 or higher

Disk space Required:

300 MB of available disk space during software
installation

Internet connection Required connection to activate the application
software and to receive software updates

Accessories

Component Requirements

PDF Reader Such as Adobe Acrobat Reader 9.0. Required to view
the HeartStart Configure 3.0 SP1 User Guide

HeartStart FR3 Secure
Digital (SD) card

Required if you configure an FR3 defibrillator using a
secure digital (SD) card

For help choosing a secure digital (SD) card, see
Selecting Accessories on page.24.

3 - Installing HeartStart Configure
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Component Requirements

Email client (MAPI
compliant)

Required to complete software installation if you are
activating the software by email

Infrared Data Association
(IrDA) adapter (for
HeartStart FRx and
HeartStart HS1 only)

Required to retrieve and send information from
HeartStart HS1 or HeartStart FRx defibrillators

Infrared adapters are available from Philips.

For help choosing an infrared adapter, see Selecting
Accessories on page.24.

Card reader (for HeartStart
FR3 only)

Required if you configure an FR3 defibrillator using a
secure digital (SD) card

For help choosing a card reader, see Selecting
Accessories on page.24.

Bluetooth adapter (for
HeartStart FR3 equipped
with Bluetooth only)

Required if you configure an FR3 defibrillator using
the Bluetooth 2.0 wireless transfer interface

For help choosing a Bluetooth adapter, see Selecting
Accessories on page.24.

Using the Installation CD-ROM
Youmust use the installation CD-ROM to install HeartStart Configure on your
computer. You can install HeartStart Configure on only one computer.

If you need to reinstall this software on your computer or install it on a different
computer, youmust first uninstall the software.

The CD contains:

• Philips HeartStart Configure software

• HeartStart Configure user guide and quick reference guide

• A ReadMe file that describes the software release. The ReadMe file might also
contain late-breaking news related to the software release.

Youmust have administrator privileges to install HeartStart Configure.
HeartStart Configure is installed on a per-user basis.

3 - Installing HeartStart Configure
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To install from the CD

You can install Philips HeartStart Configure to the default location, or select a
preferred destination folder to create the directory.

1. Insert the Philips HeartStart Configure CD in the drive on your computer.
The Philips HeartStart Configure installation wizard should start automatically.

If it does not, then useWindows Explorer to browse the CD for the
Configure30Installer.exe file, and double-click it.

2. Click Install to start the installation, and follow the on-screen instructions.

3. Click Finish.

Starting HeartStart Configure
After installation, HeartStart Configure is available from the All Programs menu.

To start Philips HeartStart Configure

1. Click Start, and then click All Programs.

2. Click Philips HeartStart Configure 3.0, and then click Configure.

Uninstalling HeartStart Configure
If you want to reinstall HeartStart Configure on your computer or install the software
on a different computer, youmust uninstall the software from your computer while it
is connected to the Internet.

You cannot activate and use the software on a different computer until you have first
uninstalled and deactivated the software on the current computer.

If you do not have an Internet connection, see Contacting Customer Support on
page.77.

To uninstall Philips HeartStart Configure from your computer

1. Verify that your computer is connected to the Internet.

2. From the Start menu, click Control Panel.

3. Click Add or Remove Programs.

4. Select Configure from the list.

5. Click Remove.

3 - Installing HeartStart Configure
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Activating the Software
In order to use Philips HeartStart Configure, youmust first activate your software.
You can do this either by Internet (in which case youmust have an Internet
connection on your computer) or by email.

Activating the Software by Internet
Philips recommends that you activate your software by Internet, since there is no
wait period to use the software using this method.

Your computer must have an Internet connection in order to immediately
activate and use your software.

To activate the software by Internet

1. Start HeartStart Configure.
The HeartStart ActivationWizard opens.

2. In the Serial Number box, type the product serial number that you received.

Your serial number is an 18-digit alphanumeric code under a bar code, see 1 in
the following figure.

All "0" characters are numeric zero.

3. Click I want to activate the software over the Internet.

17
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4. Click Activate.

The software sends the information, and a confirmationmessage states that the
software is ready for use.

Activating the Software by Email
Using the Internet to activate HeartStart Configure is the preferred activation
method.

If you cannot activate your software over the Internet, however, then you can click
email Philips Activation Support. If you need help, contact customer support.
However, support for issues that involve email activation is available only in English.

Activation by email can take several business days. During this period, you cannot
use the software. Please allow sufficient time for your request to be processed.

After Philips Customer Support receives your email activation request, you will
receive an email with the activation code.

Youmust have an email application installed on the computer that runs HeartStart
Configure. If an email application is not on your computer, then see Contacting
Customer Support on page.77.

To send the software activation request by email

1. In the HeartStart ActivationWizard, type the product serial number that you
received into the Serial Number box.

2. Click I want to activate the software by email.

3. Click Next.

4. Click Request Activation Code to open your email application.

Your email application opens a new message with the Activation.bin file
attached. You can type additional information as needed.

5. Click Send to send the activation request email to Philips Customer Support.

Customer support will send you an email with the activation code.

When you receive an email from Customer Support

1. Start HeartStart Configure.

The HeartStart ActivationWizard appears.

2. Click I want to activate the software by email.

3. Click Next to access the Activate by Email page.

4 - Activating the Software
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4. Type the activation code in the Enter your activation code here field.

5. Click Activate.

The wizard displays a confirmationmessage. Your software is ready for use.

4 - Activating the Software
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Introducing HeartStart
Configure

HeartStart Configure is a software product used to configure your HeartStart FR3,
HeartStart FRx, or HeartStart HS1 defibrillator based on your medical director's
desired protocol for response to a sudden cardiac arrest (SCA) emergency.

HeartStart Configure 3.0 is amedical device according to US Food and Drug
Administration (FDA) and EU medical device requirements.

This software transfers a new configuration to your defibrillator using one or more
transfer methods.

Philips HeartStart Configure software helps you quickly configure a HeartStart
defibrillator. With this software, you can do the following:

• Usemenu options and workspaces that help you retrieve and send a
configuration, and create, view, andmodify parameter settings in a configuration

• Transfer a configuration from your computer to a defibrillator

• Create, edit, save, and delete configurations, andmake them available for use
on another computer that runs HeartStart Configure

• Use wizards to guide you through defibrillator configuration steps

What is Configure?
With HeartStart Configure, you canmanage a defibrillator configuration on your
computer.

• Retrieve andmodify an existing configuration, and then send themodified
configuration to your defibrillator.

• Create and save a configuration for reuse later to standardize the behavior of an
entire fleet of defibrillators.
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• Exchange configurations with other users on computers that run HeartStart
Configure so that they can standardize the behavior of their defibrillators.

To create or modify a configuration, you do not have to be connected to your
defibrillator. You can use HeartStart Configure to create a configuration on your
computer, and then transfer the configuration to your defibrillator later.

HeartStart Configure uses a common set of tasks to help you change the settings on
your HeartStart FR3, HeartStart FRx, and HeartStart HS1models. The following is
a common task:

1. Establish a connection between HeartStart Configure and the HeartStart
defibrillator to retrieve the defibrillator's current configuration.

2. In the Configurations workspace, modify the defibrillator configuration.

3. Load themodified configuration to the defibrillator to set its behavior in an
emergency setting.

4. Save the configuration for reuse later on other defibrillators.

You can also use HeartStart Configure to import configurations created in older
programs, such as HeartStart Configure 2.0 and Event Review 3.5.

Who Uses Configure?
Typical HeartStart Configure users include Automated External Defibrillator (AED)
program administrators, medical directors, hospital biomedical engineers, and
emergency medical technicians. They do the following:

• View and update defibrillator configurations to determine defibrillator behavior
during an emergency

• Set the HeartStart FR3 date and time, modify language settings, and enable
bilingual operation

The System Administrator or IT users install the software, view andmanage system
activity, and perform troubleshooting activities.

Configuring a Defibrillator
To configure a defibrillator, you retrieve the current configuration from the
defibrillator, view it, change its settings, and then send it back to the defibrillator.

You can also save this configuration for later use to standardize the setting of other
defibrillators or a fleet of defibrillators.

5 - Introducing HeartStart Configure
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Changing configuration parameter settings affects the way that a defibrillator
performs in an emergency.

Configuration settings differ for each defibrillator model. When you configure a
HeartStart defibrillator, you change the default settings entered in the defibrillator's
memory at the factory.

Themethod used to transfer configuration information from the defibrillator to Philips
HeartStart Configure and back again varies for each defibrillator model. The
HeartStart FR3 uses Bluetooth or a secure digital (SD) card to transfer a
configuration, while the HeartStart FRx and HeartStart HS1 both use infrared (IrDA)
to transfer configuration information.

The following table lists topics that help you configure a HeartStart defibrillator.

Configuration Topics

Tasks Details

Retrieve and view a
defibrillator configuration

See the appropriate topic for the HeartStart
defibrillator model:

Retrieving a HeartStart FR3 Configuration on
page.37.

Retrieving a HeartStart FRx Configuration on
page.49.

Retrieving a HeartStart HS1 Configuration on
page.55.

Change the configuration
settings

See Modifying Configurations on page.64.

Send a modified
configuration to a
defibrillator

See the appropriate topic for the HeartStart
defibrillator model:

Sending a HeartStart FR3 Configuration on page.40.

Sending a HeartStart FRx Configuration on page.52.

Sending a HeartStart HS1 Configuration on
page.58.

Save a configuration for
later use

See Saving Your Work on page.66.

5 - Introducing HeartStart Configure
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Tasks Details

Delete a configuration See Deleting Configurations on page.66.

Use configuration files from
another computer

See Importing a Configuration File on page.68.

Save configuration files to
other computers

See Exporting a Configuration File on page.69.

Save a configuration for
later use

See Saving Your Work on page.66.

Delete a configuration See Deleting Configurations on page.66.

Use configuration files from
another computer

See Importing a Configuration File on page.68.

Save configuration files to
other computers

See Exporting a Configuration File on page.69.

Selecting Accessories
Select the accessory you need for your defibrillator model or computer. Accessories
are identified by a reference number. To order an accessory, contact your local
Philips representative. For more information, see Contacting Customer Support on
page.77.

Accessory Description

Computer IrDA adapter Product ID: ACT-IR

ACTiSYS ACT-IR4002US or any Infrared Data
Association (IrDA) approved adapter

HeartStart FR3 defibrillator
Bluetooth wireless technology
transceiver module

Product ID: 989803150081

HeartStart FR3 Language
Card

Product ID: 989803150101

HeartStart FR3 Secure Digital
(SD) card

Product ID: 989803150061

5 - Introducing HeartStart Configure
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Accessory Description

Secure Digital (SD) card
reader

Product ID: M3524A

You can use any Microsoft®-compatible SD card
reader. For more information, see
http://www.microsoft.com/hardware/default.aspx

Supported Microsoft®
Windows Bluetooth adapters

Most Microsoft®- compatible Bluetooth adapters
work with HeartStart FR3 defibrillators, such as IO
Gear GBU421

5 - Introducing HeartStart Configure
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Understanding How to Use
HeartStart Configure

The navigation pane on the left contains links to select tasks. Selected tasks are
displayed in the workspace to the right of the navigation pane.

Use the navigation pane to select three workspaces:

• Use theGetting Started navigation button to learnmore about HeartStart
Configure, select accessories for your defibrillator, or check for software
updates.

• Use the Configurations navigation button to retrieve a configuration, modify its
settings, and send the configuration back to the defibrillator to change its
behavior. You can also import and export a defibrillator configuration, set the
HeartStart FR3 date and time, and change HeartStart FR3 language settings.

• Use the Administration navigation button to view the System Log, view system
activity, or send the System Log to Philips technical support for review.

To access online Help

• Press F1 to display the help contents or (on themenu or toolbar) click Help and
then click HeartStart Configure Help.

• You can also click the Help tab on the right side of the window to open the Help
pane. A Help topic appears for the workspace that you are using. Click Related
Topics to navigate to other supporting topics.

To access the user guide

• On themenu, click Help, and then click HeartStart Configure User Guide.

The first time that you start the software, the navigation and help panes are both

open. You canminimize them by clicking the Auto Hide  button in the upper right
corners of either pane. The panes are then shown as tabs on the edge of the window.
To temporarily maximize either pane, hover the cursor over its tab. To restore a

pane, click the Auto Hide  button again.
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The following illustration describes available navigation buttons, features, and links
in HeartStart Configure:

Number Description

1 The title bar displays the product name and software version.

2 The toolbar displays the actions that you can perform for the selected workspace as
represented by icons.

3 The menu bar displays appropriate menus for the workspace. Use the menu bar to select
the actions that you want to perform.

4 In the workspace, you can work on defibrillator configuration tasks. The options and
features change depending on the navigation button you select.

5 The navigation pane lists configuration tasks that you can perform in the workspace. The
pane content changes depending on which button is clicked and the workspace that is
active.

6 The navigation buttons in the navigation pane display the Getting Started, Configurations,
and Administration workspaces.

7 The Help tab displays the online help topic for the workspace.

6 - Understanding How to Use HeartStart Configure
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Using the Navigation Pane
The navigation pane provides quick access to features in HeartStart Configure. For
example, when you click the Configurations button, the navigation pane displays
Configuration Tasks and Saved Configurations. When you click the Configurations
button, the toolbar displays icons that you can use to change a defibrillator's
settings.

Each pane lists features that you can use in the workspace. For more information,
see Using theWorkspace on page.29.

When you first start the software, the navigation pane is open. You can also hide or
temporarily display it.

Minimize the navigation pane by clicking the Auto Hide  button in the upper right
corners of either pane. The pane is represented by a tab on the left edge of the
window. To temporarily display the pane, hover the cursor over the Navigation tab.

To restore a pane, click the Auto Hide  button again.

Using the Workspace
The workspace is the large area located to the right of the navigation pane. The
information it displays depends on the navigation pane button you selected.

Each navigation button opens a separate workspace.

• TheGetting Started workspace includes information on how to use the
software, select accessories, and check for software updates. This
workspace appears when you start the software.

• In the Configurations workspace, you can configure a defibrillator. You can
also set the HeartStart FR3 date and time, and change the language
settings for HeartStart FR3 defibrillators.

• The Administration workspace displays the System Log of software
activities.

Understanding the Getting Started Workspace
When opened, HeartStart Configure displays the Getting Started workspace. This
workspace provides basic information about using the HeartStart Configure
software.

6 - Understanding How to Use HeartStart Configure
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TheGetting Started workspace displays the following resources:

• Introduction displays the online Help system. Use online Help to learn
more about configuration tasks.

• Select Accessories helps you identify accessories that your defibrillator
model requires to transfer a configuration, such as secure digital (SD) card
readers, Bluetooth adapters, and infrared (IrDa) adapters.

• Check for Software Updates displays any updates to HeartStart
Configure that are available for download. Philips encourages you to check
for updates every time you use HeartStart Configure.

Understanding the Configurations Workspace
In the Configurations workspace, you can decide how your defibrillator operates
during a cardiac arrest emergency.

In the navigation pane, click Configurations to open the Configurations workspace.
Here you can do the following:

• Retrieve and view the current settings from your defibrillator

• Modify defibrillator configuration settings

• Transfer the resulting configuration to your defibrillator

• Save your configuration for reuse later on other defibrillators

• Delete a previously saved configuration file

• Export a configuration so that other users can standardize how their defibrillators
operate in an emergency

• Import a configuration created by a different user from another computer or file
system

TheConfigurations workspace includes two panes:

• Use Configuration Tasks tomodify parameter settings or save a configuration
for reuse later. You can also restore a defibrillator's default settings.

• Use Saved Configurations to select a previously created configuration from a
list, open the configuration in the workspace tomodify it, and then send it to a
defibrillator.

You can set the HeartStart FR3 date and time, and change language settings:

• To set the date and time, see Setting the HeartStart FR3Clock on page.42.

• To set the language and enable bilingual operation, see Setting the HeartStart
FR3 Language on page.44.

6 - Understanding How to Use HeartStart Configure
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You can use configurations that were created on other computers that run HeartStart
Configure, Event Review 3.5, or HeartStart Configure 2.0. You can also export a
configuration to another computer. This allows other users of HeartStart Configure to
update their defibrillators in a standardized way.

Understanding the Administration Workspace
The Administration workspace contains the System Log. Use the System Log to
view system activity recorded by the software or to conduct troubleshooting. For
more information, seeWorking with the System Log on page.73.

HeartStart Configure records system activity and writes it to the System Log as
messages. You can view a table of System Logmessages. For more information,
see System LogMessages on page.115.

Customer support might ask you tomail the HeartStart Configure System Log
information. On the Helpmenu, click Email logs to Customer Support.

6 - Understanding How to Use HeartStart Configure



[This page intentionally left blank]



7

Changing Defibrillator
Settings

With Philips HeartStart Configure software, you can change how your defibrillator
behaves in an emergency. You can create a configuration to change the behavior of
a single defibrillator, or a fleet of defibrillators.

Changing a defibrillator's configuration settings can change its behavior during
an emergency. Beforemodifying defibrillator configurations, refer to the device
owner's manual.

This section introduces basic configuration tasks for the HeartStart FR3, HeartStart
FRx, and HeartStart HS1 defibrillator models.

More advanced configuration tasks are covered inWorking with Configurations on
page.61.

Basic configuration tasks include the following:

• Retrieving and viewing a defibrillator's configuration

• Modifying a configuration

• Sending the configuration to your defibrillator

You can also save a configuration for later use on other defibrillators, or export a
configuration to colleagues; they can then update and standardize the configuration
of their defibrillators.

Working with HeartStart FR3 Defibrillators
With the HeartStart FR3 defibrillator, you can retrieve and send a configuration using
Bluetooth or a secure digital (SD) card. You can also set the time and date, change
the language settings using a secure digital (SD) card, or use an optional language
card. When you change language settings, you can also choose to operate the
defibrillator in bilingual mode.
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The HeartStart FR3 displays information using an LCD screen.

Becausemany patient-care protocol parameters interact with each other, it is
important to understand how each parameter setting affects the protocol. For
more information, either see the Instructions for Administrators Guide or
consult your medical director.

In the Configurations navigation pane, you can do any of the following:

• Click Create for FR3 to create a new configuration.

• Click Set FR3 Clock to set the HeartStart FR3 date and time.

• Click Set Language Options to set your defibrillator primary language, or
enable bilingual operation.

Typical HeartStart FR3 Configuration Tasks
The following table lists tasks that you typically complete with a HeartStart FR3.

Tasks Details

Preparing the HeartStart FR3 to transfer
configuration information

See Preparing the HeartStart FR3 to Transfer Configurations on
page.35.

To use Bluetooth connections:

See Using Bluetooth Connections on page.36.

See Setting up the Bluetooth Connections and Adapters on page.37.

To use a secure digital (SD) card:

See Using an SD Card to configure a HeartStart FR3 on page.37.

Retrieving a HeartStart FR3 configuration See Retrieving a HeartStart FR3 Configuration on page.37.

Modifying parameter settings See Modifying Configurations on page.64.

Sending a HeartStart FR3 configuration to
the defibrillator

See Sending a HeartStart FR3 Configuration on page.40.

Setting the HeartStart FR3 clock See Setting the HeartStart FR3 Clock on page.42.

Setting the HeartStart FR3 language See Setting the HeartStart FR3 Language on page.44.
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Preparing the HeartStart FR3 to Transfer Configurations
The HeartStart FR3 uses an optional Bluetooth or a secure digital (SD) card to
transfer information between the defibrillator and computer.

You can use either Bluetooth or an SD card to transfer a configuration to your
HeartStart FR3.

To prepare the defibrillator to transfer a configuration, youmust turn the defibrillator
on. Make sure that the pads connector is not in place.

When you connect the HeartStart FR3 defibrillator to your computer running
HeartStart Configure using Bluetooth, you can perform the following tasks:

• Retrieve and send a configuration

• Set the HeartStart FR3 date and time

To determine if HeartStart FR3 is Bluetooth-enabled, the HeartStart FR3must have
Wireless Data Transfer selected in Administrationmode. For more information on
Bluetooth connections, see Using Bluetooth Connections on page.36.

The HeartStart FR3must be in Administrationmode to perform the following tasks:

• Download the current configuration from the HeartStart FR3 to your computer
running HeartStart Configure

• Load a configuration to HeartStart FR3 using either a Bluetooth connection or an
SD data card

• Set the HeartStart FR3 date and time using Bluetooth

If you cannot access theWireless Data Transfer mode, then you do not have the
Bluetooth option. Instead, use a secure digital (SD) card to transfer a configuration.
Youmust also use an SD language card to change HeartStart FR3 language
settings. You can use a language card that comes with the HeartStart FR3
defibrillator or create one in HeartStart Configure. For more information, see Using
an SD Card to configure a HeartStart FR3 on page.37.

To place a HeartStart FR3 defibrillator in Administration mode

1. Unplug the pads connector.

2. Insert the HeartStart FR3 battery. The defibrillator sounds a beep, and the power
light at the top is solid green. Wait until the green light begins periodically
flashing.
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3. Quickly press the greenON/OFF button. Voice prompts instruct you to plug in
pads connectors. Disregard this prompt in this instance. These voice
prompts stop once you place the defibrillator in Administrationmode.

4. Press the greenON/OFF button again. The Administration tab appears. Below
the display, press and release the left soft key (soft key #1) to enter
Administrationmode.

5. The HeartStart FR3 enters Administrationmode, andAdministration appears
on the LCD display screen.

In Administrationmode, you can take a variety of other actions. These are
discussed in the following sections.

If you do not press a soft-key button while the HeartStart FR3 is in the
Administrationmode, or if no action occurs for twominutes after performing a
transfer using Bluetooth, Administrationmode times out. When this happens,
HeartStart FR3 enters standby mode. A flashing green light above the green
ON/OFF button identifies the standby mode.

To exit Administration mode

• To exit Administrationmode, press the greenON/OFF button. Wait 10 seconds
for the defibrillator to shut down.

Using Bluetooth Connections

You can transfer information using Bluetooth to your HeartStart FR3 only if you
purchased the Bluetooth option.

To verify that you have a Bluetooth card installed, place the HeartStart FR3
defibrillator in Administrationmode, and then click theWireless Data Transfer
option. If this option is not available, then you do not have a Bluetooth - equipped
HeartStart FR3.

When you transfer a configuration or set the HeartStart FR3 clock, HeartStart
Configure connects your computer to the HeartStart FR3 defibrillator using
Bluetooth, and then allows you to transfer configuration information.

When you set up the Bluetooth software and adapter, ensure that the defibrillator and
the computer that runs HeartStart Configure are within Bluetooth transmission
range. The computer and the defibrillator should be within 30 feet (10meters) of each
other.
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In HeartStart Configure, you can change the default Bluetooth wireless PIN four-
digit number 2071 to a different number if you want to implement your own security
measures for future configuration changes and patient data downloading.

If you would like to purchase a Bluetooth card for your defibrillator, click Getting
Started in the navigation pane, and then click the Select Accessories link.

Setting up the Bluetooth Connections and Adapters

In most cases, if you plug your Bluetooth adapter into your computer, your computer
automatically installs the drivers needed for your adapter. If you need to install the
adapter manually, however, then follow the instructions that camewith your
Bluetooth adapter.

Using an SD Card to configure a HeartStart FR3

If you do not have a Bluetooth card installed on the HeartStart FR3 defibrillator or
computer, you can use a secure digital (SD) card to retrieve the configuration from
the HeartStart FR3 defibrillator, modify it in HeartStart Configure, save the settings
to the SD card, and then use the SD card to load it on the HeartStart FR3
defibrillator.

The HeartStart FR3 also uses a special language card (containing a folder called a
language pack) to change primary language settings, or to enable bilingual options.
HeartStart Configure also has a language pack that you can use for this purpose. For
more information, see Setting the HeartStart FR3 Language on page.44.

To read an SD card, use your computer's card reader or plug an external card
adapter into your computer. Any SD card adapter that Windows Explorer recognizes
as a removable disk is acceptable.

Retrieving a HeartStart FR3 Configuration
Before youmodify a HeartStart FR3 configuration, youmight want to view the
current configuration.

You can use Bluetooth to retrieve a configuration from the HeartStart FR3 and save
it in HeartStart Configure. If you did not purchase the Bluetooth option, then use a
secure digital (SD) card to transfer your configuration settings from your defibrillator.

To use the Bluetooth option, ensure that there is a Bluetooth card or adapter plugged
into your computer. To set up your Bluetooth card and connection, see Using
Bluetooth Connections on page.36.
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To retrieve a HeartStart FR3 configuration using Bluetooth

1. Start HeartStart Configure on your computer.

2. Place the HeartStart FR3 in Administrationmode. For details, see Preparing the
HeartStart FR3 to Transfer Configurations on page.35.

3. On the HeartStart FR3, use the left soft key (soft key #1) to navigate to
Wireless Data Transfer mode, and then press the center soft key (soft key #2)
to select this mode.

The screenmessage Ready for Data Transfer appears.

4. In HeartStart Configure, on the toolbar, click Retrieve configuration from
defibrillator or, on the File menu, click Retrieve.

5. On theWelcome to the Configuration TransferWizard window, click Next.

6. On Select Defibrillator page, click the row with HeartStart FR3 from the list,
and then click Next.

The wizard instructs you to stand by while the configuration is transferred. The
wizard displays the following columns:

• Model: FR3
• Serial number: for example, C09B-00001
• Interface: Bluetooth

The wizard displays a page indicating whether the configuration retrieve
operation is successful or not.

7. Click Finish.

The Configurations workspace displays the configuration fields.

To retrieve a HeartStart FR3 configuration using an SD card

1. Verify that there is an SD card in the HeartStart FR3. The slot is located inside
the battery compartment.

2. Place the HeartStart FR3 in Administrationmode. For more information, see
Preparing the HeartStart FR3 to Transfer Configurations on page.35.

3. On the HeartStart FR3, use the left soft key (soft key #1) to navigate down the
list. Using the center soft key (soft key #2), select Setup.

4. Using the left soft key (soft key #1), navigate down the list. Then, use themiddle
soft key (soft key #2) to select Save Setup to Data Card.

A verificationmessage, Saved to Card, appears.

5. To turn the defibrillator off, press the greenON/OFF button.

6. Remove the battery from the HeartStart FR3, and remove the SD card.
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7. Insert the card into your computer's SD card reader or adapter.

8. In HeartStart Configure, click the Configurations navigation button.

The Configurations workspace opens.

9. From the toolbar or file menu, click Retrieve.

TheWelcome to the Configuration TransferWizard page displays.

10. Click Next.

The Select Defibrillator page displays, and shows available SD card drives.
Unavailable drives are unavailable.

11. Click the drive with the SD data card, and then click Next.

The TransferWizard indicates whether the configuration retrieve operation is
successful or not.

12. Click Finish.

The retrieved configuration appears in the Configurations workspace.

Modifying a HeartStart FR3 Configuration
Use the Configurations workspace tomodify a configuration's settings. Each field
has amenu list that lists the allowed settings for that field.

Becausemany patient-care protocol parameters interact with each other, it is
important to understand how each parameter setting affects the protocol. For
more information, see the Instructions for Administrators Guide or consult your
medical director.

HeartStart Configure provides tool tips with short descriptions of each configuration
parameter. Hover the cursor over an information icon near the parameter to display
the description.

Keep these two typographical conventions in mind when using the fields andmenu
list to select parameter settings:

• In fields, the factory default settings are in regular black text, and nondefault
settings are highlighted as bold blue text. This helps makemodified fields more
obvious.

• In menu lists, the factory default settings are highlighted in bold text, and
nondefault values are in regular black text.

HeartStart Configure also turns fields on and off based on other settings you select.
If a field has gray wavy lines through it, it depends on another field and cannot be
changed until that related field is modified.
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To modify a HeartStart FR3 configuration

You can set all fields to original factory default settings by clicking Restore
Defaults .

1. Click the Configurations navigation button to display the Configurations
workspace.

2. (Optional) If you did not retrieve the HeartStart FR3's current configuration, then
in Configuration Tasks, click the Create for FR3 link to create a new
configuration.

3. (Optional) Type ameaningful name and description in the Configuration Name
and Configuration Description fields.

The new information replaces the selection.

4. Click the parameter that you want to change.

A menu list appears.

5. In the openmenu list, click a setting.

6. (Optional)When you are satisfied with your changes, on the File menu or

toolbar, click Save to save it for future use.

Using Click Mode

To prevent unintentional setting selections, use Click Mode. This is the default
selectionmode for mouse operation. Click Modemeans that youmust first click a
field to see themenu of available settings, and then click themenu list to select a
setting. Themenu list disappears when you click away from the field.

If you uncheck Click mode (by clicking Tools, thenOptions), you can hover the
cursor over a field to display themenu list (without needing to click), and then click
an item in the list to change a setting.

Sending a HeartStart FR3 Configuration
After you retrieve a configuration from the HeartStart FR3 andmodify the
configuration settings in the Configurations workspace, you can send the
configuration to your HeartStart FR3 tomodify how the defibrillator behaves in an
emergency.

Alternatively, if you did not send the resulting configuration to your HeartStart FR3
using Bluetooth, then use an SD data card to transfer your configuration settings to
your defibrillator.
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To send a HeartStart FR3 defibrillator configuration using Bluetooth

1. Start HeartStart Configure on your computer.

2. Place the HeartStart FR3 in Administrationmode. For details, see Preparing the
HeartStart FR3 to Transfer Configurations on page.35.

3. On the HeartStart FR3, use the left soft key (soft key #1) to navigate to
Wireless Data Transfer mode, and then press the center soft key (soft key #2)
to select themode.

The screenmessage Ready for Data Transfer appears.

4. On the File menu, click Send, or on the toolbar, click Send configuration to
defibrillator .

TheWelcome to the Configuration TransferWizard page appears.

5. Click Next.

6. Click the HeartStart FR3 configuration, and then click Next.

7. On the Select Defibrillator Page, wait for the HeartStart FR3 to appear in the
list.

8. Click the row with the correct defibrillator in it, and then click Next.
A page appears instructing you to stand by while the configuration is transferred.
The TransferWizard displays a page indicating whether the configuration send
operation is successful or not.

9. Click Finish.

To transfer a HeartStart FR3 configuration using an SD card

1. If you have not yet already done so, insert an SD card in your computer's SD
card reader or adapter.

2. On the File menu or toolbar, click Send .

TheWelcome to the Configuration TransferWizard page appears.

3. Click Next.

The Select Defibrillator page opens and displays removable drives, highlighting
the drive with the SD card.

4. Click the drive with the SD data card, and then click Next.

A page appears instructing you to stand by while the configuration is transferred.
This page shows themodel, serial number, and interface (connection)
information.
The TransferWizard displays a page indicating whether the send operation is
successful or not.
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5. Click Finish.

To load a HeartStart FR3 defibrillator configuration using an SD card

1. Remove the SD card from your computer's SD card reader or adapter.

2. Remove the HeartStart FR3 battery.

3. If there is an SD card in your HeartStart FR3, remove it. It is located inside the
battery compartment.

4. Insert the SD card with your saved configuration in the HeartStart FR3 SD card
slot.

5. Replace the HeartStart FR3 battery.
The defibrillator beeps once.

6. Press the greenON/OFF button to turn on the defibrillator.

7. Place the defibrillator in Administrationmode. For more information, see
Preparing the HeartStart FR3 to Transfer Configurations on page.35.

8. Press the left soft key (soft key #1) to use the Down arrow.

9. Press themiddle soft key (soft key #2) to select Setup.

10. Press the left soft key (soft key #1) to navigate down the list to Load New
Setup

11. Press themiddle soft key (soft key #2) with the blue check mark to load the
configuration.

The HeartStart FR3 displays the screenmessage, Setup Complete.

Setting the HeartStart FR3 Clock
Use the Set FR3 Clock link in the left navigation pane to synchronize the HeartStart
FR3 date and time with that of your computer.

The HeartStart FR3must have the Bluetooth option to change the clock using
HeartStart Configure.

Philips recommends that you remove case data from the HeartStart FR3
defibrillator before you synchronize the date and time. This is to prevent time
stamps in the patient data from inadvertently being changed. Use one of the
Philips Event Review datamanagement solutions first to download your
patient event summary data.

The Set Clock Wizard consists of the following pages:
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• A Welcome page where you can learnmore about the wizard. You can
choose to bypass this page in the future.

• A Date and Time page shows the computer's date and time. The date and
time that is running on the computer displays in the wizard, and the software
continues to update the time until it communicates with the defibrillator, at
which point the date and time are adjusted. You can also use the control box
to further adjust the time inminutes if you want to use a time that is different
from that of your computer.

• A Selection Page displays information about the state of your defibrillator.

The following table describes the information shown in each field of the selection
page:

Data
Column Details

Connection
State

Whether or not the defibrillator is ready. Possible values are:

Ready: the defibrillator is compatible with the information being
transferred.

Offline : the defibrillator was found in a recent scan but is now not
available for connection.

Incompatible: the defibrillator is ready but cannot receive the
information being transferred.

Serial
Number

The defibrillator's serial number found in the scan

Connection The type of defibrillator transfer method used

Model The defibrillator model

• A Processing page indicates that the computer and defibrillator are
connecting.

• A Status page indicates either success or failure for the time-set operation.

To synchronize the HeartStart FR3 clock

1. Place the HeartStart FR3 in Administrationmode.

For details, see Preparing the HeartStart FR3 to Transfer Configurations on
page.35.

2. In Philips HeartStart Configure, click Configurations.
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3. Under Configuration Tasks in FR3Configuration, select the Set FR3 Clock
link to start the FR3 Set Clock wizard.

To set the HeartStart FR3 to a time that is different than that of your computer,
use the Offset in Minutes control box. You can set the HeartStart FR3
defibrillator's time inminutes forward or backward relative to the computer's
clock, up to amaximum of 1,440minutes (24 hours).

4. Follow the on-screen instructions to transfer the time and date settings to the
HeartStart FR3 defibrillator. If the transfer is successful, the HeartStart FR3
defibrillator displays the correct date and time.

Setting the HeartStart FR3 Language
Using HeartStart Configure, you can do the following:

• Change language settings for the locale in which you use the defibrillator

• Change the primary language

• Choose an optional secondary language for bilingual operation

When the HeartStart FR3 is configured for bilingual operation, responders can
choose between a primary and a secondary language after turning on the HeartStart
FR3.

Youmust use a secure digital (SD) card to save your language configuration and
transfer it to a HeartStart FR3. For more information, see Using an SD Card to
configure a HeartStart FR3 on page.37.

The Set Language Options wizard consists of the following pages:

• A Welcome page. You can choose to bypass this page in the future.

• A Language Pack Location page. Here you can choose from a list of available
language packs. HeartStart Configure has a HeartStart FR3 language pack, as
does the available HeartStart FR3 language card. You can use either.

• A Specify Language Package Options page. Here you can choose a primary
language for the HeartStart FR3 from a list of languages. You can also select a
secondary language for bilingual operation.

• The Save Configuration Options page. Here you can select the drive on which
to save your language selections. The page displays information for the selected
location, such as the volume name, the file system, free space available, and
the total size of the file.

• A status page indicates whether you have successfully saved your language
configuration or not.
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To set HeartStart FR3 language options

1. On the HeartStart Configure navigation pane, click the Configurations
navigation button to display the Configurations workspace.

2. On the navigation pane under FR3 Configuration, click Set Language
Options.

The Set LanguageOptions Welcome to the FR3 LanguageWizard page
appears.

3. Click Next.

4. (Optional) Insert a language card into your computer's SD card reader or
adapter.

5. On the Language Pack Location page, locate the language pack that you want to
use.

The Computer location contains the language pack installed with the HeartStart
Configure software.

6. (Optional) If you are using the language card, locate the drive letter location, and
then click the drive to open the language pack.

Inactive drives are indicated by gray text. The Language Packages field shows
the name and description of the language pack.

7. Click Expand  to display the available languages on the language pack.

To verify if the language pack is compatible with your HeartStart FR3 version,
click the Information  icon to display a brief description of the language
pack.

8. Click Next.

The Specify Language PackageOptions page displays. At the top of the
LanguageOptions pane, the name of the language pack that you selected
appears in the Language Pack field.

9. To select the primary language, click the Primary language down arrow to
open the list box, and then click a language from the list.

You can click Unchanged to keep the current setting on the device.

10. (Optional) To set bilingual operation, click the checkbox, Enable bilingual
operation, click the down arrow to open the list box, and click a language from
the list.

11. Click Next.

The Save Configurations Options page appears. Inactive drives are indicated by
gray text. The Drive Details pane shows details of the drive you select: the
Volume name, the File system, amount of Free space, and the Total size.
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Youmay be prompted to overwrite any existing configuration information on the
target SD card.

12. Click Next to save your language configuration to the target SD card.

The language configuration is saved, and the wizard displays a status page
informing you whether the save was successful or not, and to what drive the
configuration is saved.

13. Remove the card with your saved language configuration from your computer's
SD card reader or adapter.

Loading new HeartStart FR3 primary and secondary languages

1. Remove the HeartStart FR3 battery, and then locate the card slot at the bottom
of the battery compartment. If there is an SD data card in the slot, first remove it.

2. Insert the card with the saved language configuration in the card slot.

3. Reinstall the battery while holding down the right soft key (soft key #3). Keep the
soft key pressed until the blank screen with the speaker icon displays.

The HeartStart FR3 display screen displays green progress bars as the
languages load.

4. The new language file automatically loads. The HeartStart FR3 displays the
language name and a progress bar. During language installation, the HeartStart
FR3 cannot be turned off.

If the new language installation does not complete, the HeartStart FR3 reverts
to the default primary language and displays a setup error screen.

5. When the language load is complete, the HeartStart FR3 displays the following
screenmessages: Setup Complete and Remove Language Card. If an error
occurs during loading, the HeartStart FR3 displays a Setup Errormessage in
the default language.

6. Remove the card from the HeartStart FR3, and insert the battery.

The HeartStart FR3 performs a user-initiated test (UIT).

7. To enable bilingual option on the HeartStart FR3, press the greenON/OFF
button. The defibrillator beeps once.

The HeartStart FR3 prompts you with a voicemessage to select either the
primary language (left soft key, or soft key #1) or the secondary language (right
soft key, or soft key #3). The language selections display on the tabs at the
bottom of the HeartStart FR3 LCD screen.

8. Select the secondary language by selecting the right soft key (soft key #3).
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If you do not select the secondary language within 10 seconds, the HeartStart
FR3 continues to operate in the primary language.

The HeartStart FR3 announces the language selection and uses that language
for all operation until the HeartStart FR3 returns to standby mode.

Youmust select either the primary or the secondary language each time you turn
on the HeartStart FR3 for use.

Working with HeartStart FRx Defibrillators
There are two types of HeartStart FRx defibrillators: the original model that follows
year 2000 guidelines, and a newermodel that follows year 2005 guidelines. If you
attempt to update a HeartStart FRx using the wrong configuration guideline,
HeartStart Configure indicates that the configuration is incompatible with the
HeartStart FRx model.

To find out the guideline that is used by your defibrillator, check the back side of the
defibrillator. On a HeartStart FRx programmed for 2005 guidelines, you will see a
small white label that says "2005Guidelines." If your HeartStart FRx does not have
this label, then it is programmed for 2000 guidelines.

Typical HeartStart FRx Configuration Tasks
The following table lists tasks that you typically complete with a HeartStart FRx.

Tasks Details

Preparing your HeartStart FRx
to transfer a configuration
using an infrared connection

See the appropriate topic for the FRx defibrillator
model:

Preparing the HeartStart FRx to Transfer
Configurations on page.48.

Setting Up Infrared Connections and Adapters on
page.53.

Retrieving a configuration See Retrieving a HeartStart FRx Configuration on
page.49.

Modifying default parameter
settings

See Modifying Configurations on page.64.

Sending and receiving a
configuration

See Sending a HeartStart FRx Configuration on
page.52.
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Setting Up Infrared Connections and Adapters
HeartStart Configure communicates with your HeartStart defibrillator over an
infrared connection.

On an initial installation of your infrared adapter, if the drivers do not install
automatically, then insert the CD-ROM that camewith your infrared adapter and use
the New HardwareWizard on your computer to set up the adapter.

You can usemost USB infrared adapters to transfer a configuration between a
computer running Philips HeartStart Configure and a defibrillator that uses infrared
as the transfer method.

Philips HeartStart Configure recognizes when an infrared adapter is plugged into the
computer and is available. A Windows notification indicates that data can be
transferred by the infrared connection. You do not have to perform any additional
steps.

Use the default device drivers for the adapter. For best results, plug the
hardware adapter into the USB port and use the default Windows driver.

Position the computer and the defibrillator infrared transfer windows so that they are
facing each other and are at least 12 inches apart.

Preparing the HeartStart FRx to Transfer Configurations
To transfer a configuration to the HeartStart FRx, youmust first place the
defibrillator in Administrationmode. The defibrillator must be turned on, and the pads
connector must not be in place.

The HeartStart FRx uses infrared (IrDA) to communicate with your computer.
Philips recommends that you start HeartStart Configure before placing HeartStart
FRx in Administrationmode.

In order to transfer a configuration, your computer IrDA window or adapter and the
defibrillator IrDA window must face one another. For more information, see Setting
Up Infrared Connections and Adapters on page.53.

Administrationmode times out after threeminutes for a first-time connection
between a HeartStart FRx defibrillator and computer. Once the software
connects to the defibrillator, the timeout is 30minutes from the last connection.
Each time a configuration is sent, the timeout resets.
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To place a HeartStart FRx Defibrillator in Administration mode

1. Remove the pads connector.

2. If you haven't done so already, insert the battery into the defibrillator.

You will hear voice prompts to plug in pads connectors. Disregard these
prompts in this instance. Thesemessages end once you place the defibrillator
in Administrationmode. For more information, see Understanding Voice and
ScreenMessages on page.113.

3. Press the green >ON/OFF button.

4. On the defibrillator, press and hold the blue Information button, and wait for
three tones.

5. Release the blue Information button.

The voicemessage announces Administration. The defibrillator enters data
transfer mode, and you can now configure your defibrillator.

6. Position the defibrillator to communicate with the computer.

The defibrillator and computer should be at least 12 inches apart.

To exit Administration mode

1. Press the greenON/OFF button.

2. After you have transferred the configuration, plug in the pads connector.

The defibrillator is now ready for use on a patient.

Retrieving a HeartStart FRx Configuration
Before changing your HeartStart FRx configuration settings, youmay want to first
view the current settings. You can use Infrared (IrDA) to retrieve a configuration from
the HeartStart FRx and view it in HeartStart Configure.

HeartStart FRx defibrillators use an IrDA connection to communicate with your
computer. For more information on setting up a IrDA connection, see Setting Up
Infrared Connections and Adapters on page.53.

To retrieve a HeartStart FRx configuration

1. Position the computer IrDA window or attached IrDA adapter and the HeartStart
FRx defibrillator IrDA window so that they face each other. The computer
running HeartStart Configure and defibrillator should be at least 12 inches apart.
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2. In Philips HeartStart Configure, click the Configurations navigation button to
display the Configurations workspace.

3. Place the HeartStart FRx in Administrationmode. For more information, see
Preparing the HeartStart FRx to Transfer Configurations on page.48.

4. On the toolbar, click Retrieve configuration from defibrillator, or on the File
menu, click Retrieve .

TheWelcome to the Configuration TransferWizard window appears.

5. Click Next.

6. On the Select Defibrillator page, select the row with the HeartStart FRx link in
it, and then click Next.

A page appears while the configuration is sent from the defibrillator. This page
shows themodel, serial number, and interface (connection) information. The
HeartStart FRx defibrillator voicemessage announces Transferring data to
indicate that the computer is receiving information from the defibrillator.

7. Wait for the HeartStart FRx to sound three confirmation tones.

The wizard displays a page indicating whether the configuration retrieve
operation is successful or not.

8. Click Finish.

The retrieved configuration appears in the Configurations workspace, and you
can now view andmodify the configuration.

Modifying a HeartStart FRx Configuration
Use the Configurations workspace tomodify a configuration file's settings. Each
field has amenu list that lists the allowed settings for that field.

Becausemany patient-care protocol parameters interact with each other, it is
important to understand how each parameter setting affects the protocol. For
more information, see the Instructions for Administrators Guide or consult your
medical director.

HeartStart Configure provides tool tips with short descriptions of each configuration
parameter. Hover the cursor over an information icon near the parameter to display
the description.

Keep these two typographical conventions in mind when using the fields andmenu
list to select parameter settings:
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• In fields, the factory default settings are in regular black text, and nondefault
settings are highlighted as bold blue text. This helps makemodified fields more
obvious.

• In menu lists, the factory default settings are highlighted in bold text, and
nondefault values are in regular black text.

HeartStart Configure also turns fields on and off based on other settings you select.
If a field has gray wavy lines through it, it depends on another field and cannot be
changed until that related field is modified.

To modify a HeartStart FRx configuration

You can set all fields to original factory default settings by clicking Restore
Defaults .

1. Click the Configurations navigation button to display the Configurations
workspace.

2. (Optional) If you did not retrieve your HeartStart FRx's current configuration,
then in Configuration Tasks, click Create for FRxA (2005 Guidelines), or
Create for FRx (2000 Guidelines) to create a new configuration.

3. (Optional) Type ameaningful name and description in the Configuration Name
and Configuration Description fields.

The new information replaces the selection.

4. Click the parameter that you want to change.

A menu list appears.

5. In the openmenu list, click a setting.

6. (Optional)When you are satisfied with your changes, on the File menu or

toolbar, click Save to save the configuration for future use.

Using Click Mode

To prevent unintentional setting selections, use Click Mode. This is the default
selectionmode for mouse operation. Click Modemeans that youmust first click a
field to see themenu of available settings, and then click themenu list to select a
setting. Themenu list disappears when you click away from the field.

If you uncheck Click mode (by clicking Tools, thenOptions), you can hover the
cursor over a field to display themenu list (without needing to click), and then click
an item in the list to change a setting.
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Sending a HeartStart FRx Configuration
After youmodify the settings in the HeartStart FRx configuration, you can use
infrared (IrDA) to send this configuration to the HeartStart FRx, to change how the
defibrillator behaves in an emergency.

HeartStart FRx defibrillators use IrDA to communicate with your computer. For more
information, see Setting Up Infrared Connections and Adapters on page.53.

You can create a new configuration to send to the HeartStart FRx. For more
information, see Creating Configurations on page.62.

To send a configuration to a HeartStart FRx

1. Position the computer IrDA window or attached IrDA adapter and the HeartStart
FRx defibrillator infrared transport window so that they face each other. The
computer running HeartStart Configure and defibrillator should be at least 12
inches apart.

2. Place the HeartStart FRx in Administrationmode. For more information, see
Preparing the HeartStart FRx to Transfer Configurations on page.48.

3. On the toolbar, click Send configuration to defibrillator, or on the File menu,
click Send .

TheWelcome to the Configuration TransferWizard window appears.

4. Click Next.

5. On the Select Defibrillator page, click the row with the HeartStart FRx link in it,
and then click Next.

A standby page appears when the configuration is sent to the defibrillator. This
page shows themodel, serial number, and interface (connection) information.
The HeartStart FRx voicemessage announces Transferring data indicating
that the defibrillator is receiving the configuration from the computer.

6. Wait for the HeartStart FRx to sound three confirmation tones.

The Transfer wizard displays a page indicating whether the configuration send
operation is successful or not.

7. Click Finish.
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Working with HeartStart HS1 Defibrillators
There are two types of HeartStart HS1 defibrillators: the original model that follows
year 2000 guidelines, and a newermodel that follows year 2005 guidelines. If you
attempt to update a HeartStart HS1 using the configuration of the wrong guideline for
that device, HeartStart Configure indicates that the configuration is incompatible
with that model of HeartStart HS1.

To find out the guideline that your defibrillator uses, look on the back of the
defibrillator. If a small white label reads "2005Guidelines," your defibrillator is
programmed for the 2005 guidelines. If your HeartStart HS1 does not have this label,
then it is programmed for 2000 guidelines.

Typical HeartStart HS1 Configuration Tasks
The following table lists tasks that you typically complete with a HeartStart HS1.

Tasks Details

Preparing the HeartStart HS1 to
transfer a configuration using
infrared connections

See the appropriate topic for the HS1 defibrillator model:

Preparing the HeartStart HS1 to Transfer Configurations on page.54.

Setting Up Infrared Connections and Adapters on page.53.

Retrieving a configuration See Retrieving a HeartStart HS1 Configuration on page.55.

Modifying a configuration See Modifying Configurations on page.64.

Sending and receiving a
configuration

See Sending a HeartStart HS1 Configuration on page.58.

Setting Up Infrared Connections and Adapters
HeartStart Configure communicates with your HeartStart defibrillator over an
infrared connection.

On an initial installation of your infrared adapter, if the drivers do not install
automatically, then insert the CD-ROM that camewith your infrared adapter and use
the New HardwareWizard on your computer to set up the adapter.
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You can usemost USB infrared adapters to transfer a configuration between a
computer running Philips HeartStart Configure and a defibrillator that uses infrared
as the transfer method.

Philips HeartStart Configure recognizes when an infrared adapter is plugged into the
computer and is available. A Windows notification indicates that data can be
transferred by the infrared connection. You do not have to perform any additional
steps.

Use the default device drivers for the adapter. For best results, plug the
hardware adapter into the USB port and use the default Windows driver.

Position the computer and the defibrillator infrared transfer windows so that they are
facing each other and are at least 12 inches apart.

Preparing the HeartStart HS1 to Transfer Configurations
To transfer a configuration to the HeartStart HS1, youmust first place the
defibrillator in Administrationmode. The defibrillator must be turned on with the pads
cartridge removed.

The HeartStart HS1 uses infrared (IrDA) to communicate with your computer.
Philips recommends that you start HeartStart Configure and prepare the IrDA
connection before placing the HeartStart HS1 in Administrationmode.

In order to transfer a configuration, your computer IrDA window or adapter and the
defibrillator IrDA window must face one another. For more information, see Setting
Up Infrared Connections and Adapters on page.53.

The Administrationmode for a HeartStart HS1 (for the initial connection to the
computer running HeartStart Configure) times out after 30 seconds for 2000
guidelines, and threeminutes for 2005 guidelines. Once the software connects
to the defibrillator, the timeout is 30minutes from the last connection. Each
time a configuration is sent, the timeout resets.
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To place a HeartStart HS1 defibrillator in Administration mode

1. Remove the pads cartridge. Locate the latch at the top, and then slide the latch
to the right to release the pads cartridge.

2. If you haven't done so already, insert the battery into the defibrillator.

You will hear voice prompts to plug in the pads cartridge. Disregard these
prompts in this instance. Thesemessages will be silenced once you place
your defibrillator in Administrationmode. For more information, See
Understanding Voice and ScreenMessages on page.113.

After the battery is inserted, the defibrillator automatically turns on.

3. If the device is not on, press the power button.

4. On the defibrillator, press and hold the blue Information button, and then wait for
three tones.

5. Release the blue button.

A voicemessage announces Administration.

6. Briefly press the blue Information button again.

The voicemessage saysMode 1.

7. Position the defibrillator to communicate with the computer.

The defibrillator and computer should be at least 12 inches apart.

If you want to retrieve a HeartStart HS1 configuration, see Retrieving a HeartStart
HS1Configuration on page.55.

If you want to send a HeartStart HS1 configuration, see Sending a HeartStart HS1
Configuration on page.58.

To exit Administration mode

1. To exit Administrationmode, press the green power button.

2. After you transfer the configuration, plug in the pads cartridge.

The defibrillator is now ready for use on a patient.

Retrieving a HeartStart HS1 Configuration
Before changing your HeartStart HS1 configuration settings, youmay want to first
view the current settings. You can use Infrared (IrDA) to retrieve a configuration from
the HeartStart HS1 and save it in HeartStart Configure.
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HeartStart HS1 defibrillators use an IrDA connection to communicate with your
computer. For more information on setting up a IrDA connection, see Setting Up
Infrared Connections and Adapters on page.53.

To retrieve a HeartStart HS1 configuration

1. Position the computer IrDA window or attached IrDA adapter and the HeartStart
HS1 defibrillator IrDA window so that they face each other. The computer
running HeartStart Configure and defibrillator should be at least 12 inches apart.

2. In Philips HeartStart Configure, click Configurations to open the
Configurations workspace.

3. Place the HeartStart HS1 in Administrationmode. For more information, see
Preparing the HeartStart HS1 to Transfer Configurations on page.54.

4. From the File menu, click Retrieve, or on the toolbar, click Retrieve
configuration from defibrillator .

TheWelcome to the Configuration TransferWizard window appears.

5. Click Next.

6. On the Select Defibrillator page, click the row with the HeartStart HS1 link in it,
and then click Next.

A standby page appears while the configuration is sent from the defibrillator.
This page shows themodel, serial number, and interface (connection)
information. The HeartStart HS1 defibrillator voicemessage announces
Sending, indicating that the computer is receiving information from the
defibrillator.

7. Wait for the HeartStart HS1 to sound three confirmation tones.
The TransferWizard displays a page indicating whether the configuration
retrieve operation is successful or not.

8. Click Finish.

The retrieved configuration appears in the Configurations workspace, and you
can now view andmodify the configuration.

Modifying a HeartStart HS1 Configuration
Use the Configurations workspace tomodify a configuration file's settings. Each
field has amenu list that lists the allowed settings for that field.
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Becausemany patient care protocol parameters interact with each other, it is
important to understand how each parameter setting affects the protocol. For
more information, see the Instructions for Administrators Guide or consult your
medical director.

HeartStart Configure provides tool tips with short descriptions of each configuration
parameter. Hover the cursor over an information icon near the parameter to display
the description.

Keep these two typographical conventions in mind when using the fields andmenu
list to select parameter settings:

• In fields, the factory default settings are in regular black text, and nondefault
settings are highlighted as bold blue text. This helps makemodified fields
more obvious.

• In menu lists, the factory default settings are highlighted in bold text, and
nondefault values are in regular black text.

HeartStart Configure also turns fields on and off based on other settings you select.
A field with gray wavy lines depends on another field and cannot be changed until
that related field is modified.

To modify a HeartStart HS1 configuration

You can set all fields to original factory default settings by clicking Restore
Defaults .

1. Click the Configurations navigation button to display the Configurations
workspace.

2. (Optional) If you did not retrieve your HeartStart HS1's current configuration,
then in Configuration Tasks, click Create for HS1A (2005 Guidelines), or
Create for HS1 (2000 Guidelines) to create a new configuration.

3. (Optional) Type ameaningful name and description in the Configuration Name
and Configuration Description fields.

The new information replaces the selection.

4. Select the parameter that you want to change.

A menu list appears.

5. In the openmenu list, select a setting.

6. (Optional)When you are satisfied with your changes, on the File menu or

toolbar, click Save to save the configuration for future use.
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Using Click Mode

To prevent unintentional setting selections, use Click Mode. This is the default
selectionmode for mouse operation. Click Modemeans that youmust first click a
field to see themenu of available settings, and then click themenu list to select a
setting. Themenu list disappears when you click away from the field.

If you uncheck Click mode (by clicking Tools, thenOptions), you can hover the
cursor over a field to display themenu list (without needing to click), and then click
an item in the list to change a setting.

Sending a HeartStart HS1 Configuration
After youmodify the settings in the HeartStart HS1 configuration, you can use
infrared (IrDA) to send the configuration to the HeartStart HS1, to change how the
defibrillator behaves in an emergency.

HeartStart HS1 defibrillators use IrDA to communicate with your computer. For
more information, see Setting Up Infrared Connections and Adapters on page.53.

You can create a new configuration to send to the HeartStart HS1. For more
information, see Creating Configurations on page.62.

To send a HeartStart HS1 configuration

1. Position the computer infrared transport window or attached IrDA adapter and
the HeartStart HS1 defibrillator infrared transport window so that they face each
other. The computer running HeartStart Configure and the defibrillator should be
at least 12 inches apart.

2. Place the HeartStart HS1 in Administrationmode. For more information, see
Preparing the HeartStart HS1 to Transfer Configurations on page.54.

3. On the toolbar, click Send configuration to defibrillator, or on the File menu,
click Send .

TheWelcome to the Configuration TransferWizard window appears.

4. Click Next.

5. On the Select Defibrillator page, click the row with the HeartStart HS1
defibrillator link in it, and then click Next.
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A standby page appears while the configuration is sent to the defibrillator. This
page shows themodel, serial number, and interface (connection) information.
The HeartStart HS1 voicemessage announces Sending, indicating that the
defibrillator is receiving the configuration from the computer.

6. Wait for the HeartStart HS1 to sound three confirmation tones.

The TransferWizard displays a page indicating whether the configuration send
operation is successful or not.

7. Click Finish.

7 - Changing Defibrillator Settings



[This page intentionally left blank]



8

Working with Configurations
Use the Configurations pane to perform various defibrillator configuration tasks.

• Manage a configuration. Create, open, modify, save, and delete a configuration.
You can also restore default settings. For more information, seeManaging
Configurations on page.61.

• Share a configuration. Import or export a configuration file to share with
colleagues. You can also communicate with a defibrillator to transfer your
configuration to it. For more information, see Transferring Configurations on
page.67.

• Organize configuration details. Customize the way that columns appear on the
table, group entries to sort the entries by multiple criteria, and sort the
information based on the column. For more information, see Displaying
Information on page.69.

For security purposes, configuration files created by one user are not visible to
other users on the samemachine.

Managing Configurations
Use the Configurations workspace to view and change defibrillator configuration
settings. You can save the configuration as a file for use by another user. This helps
to standardize configurations across a fleet of defibrillators.

Managing configurations involves the following tasks:

• Creating a configuration

• Opening a configuration

• Modifying a configuration

• Restoring default configuration settings

• Saving your work

• Deleting a configuration
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The configuration workspace appears when you click a link to open a saved
configuration or when you create a new configuration. You can also open a list of
previously saved configurations, and then select a configuration from the list.

In the Configurations workspace, you can view information for your saved
configurations. You can also sort and group configurations based on the following
information types:

• Model

• Name

• Description

• Datemodified

Within a configuration, defibrillator fields are grouped as follows for all models:

• AnOverview section of the configuration that includes the fields to identify the
configuration. You can type text in these description fields.

• A Device section that includes settings for the basic overall behavior of the
defibrillator model.

• A Defibrillation section that includes the parameter settings for the defibrillation
shock sequence.

Somemodels have fields for the following:

• A Self Test section that contains settings for automatic self-tests.

• A CPR, General CPR, or Protocol-specific CPR section that contains fields
for cardiopulmonary resuscitation protocols.

• A Voice Prompts section that contains specifications for the timing and content
of voice prompts.

Creating Configurations
When you create a configuration, the workspace displays the default parameter
settings. Once youmodify the configuration, you can do any of the following:

• Transfer it to a defibrillator

• Save it on your computer for later use

• Export it for use by a colleague on another computer running HeartStart
Configure

To create and name a new configuration

1. Click the Configurations navigation button.
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The Configurations navigation pane displays panes and links for the supported
defibrillators.

2. Use one of the followingmethods to create a configuration:

• In the Configuration Tasks navigation pane, click the defibrillator and the
guidelines link for your defibrillator model.

• On the File menu or toolbar, click New . Select a defibrillator and the
guidelines link for the defibrillator model.

HeartStart Configure opens a new configuration for the defibrillator type.

3. In the Configuration Name field, type a name for your configuration. You can
change the software-generated configuration name to a different name.

4. In the Configuration Description field, type the description for your
configuration.

5. In the User Name field, type your name.

6. On the File menu or toolbar, click Save to save your new configuration.

Opening Previously Saved Configurations
You can open and display a previously saved configuration in the Configurations
workspace using the Saved Configurations list.

To open a previously saved configuration in the Configurations workspace

1. Click the Configurations navigation button.

The Configurations workspace appears.

2. Choose between these twomethods to open your saved configuration.

• In the Navigation pane, click the All Configurations link, click a
configuration, and then double-click it to open it in the workspace. Or, you
can select the configuration in the All Configurations list, and then from the
File menu or toolbar, click File, and then click Open .

• To open a configuration for a particular defibrillator model, click the
defibrillator model link in the Saved Configurations pane (for example,
FRx Configurations), and then open the configuration either by double-
clicking it or (from the File menu or toolbar) clicking File, and then clicking
Open .
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Modifying Configurations
You can use the Configurations workspace tomodify a configuration file's settings.
Each field has amenu list that lists the allowed settings for that field.

Becausemany patient-care protocol parameters interact with each other, it is
important to understand how each parameter setting affects the protocol. For
more information, see the Instructions for Administrators Guide or consult
your medical director.

HeartStart Configure provides tool tips with short descriptions of each configuration
parameter. Hover the cursor over an information icon near the parameter to display
the description.

Keep these two typographical conventions in mind when using the fields andmenu
list to select parameter settings:

• In fields, the factory default settings are in regular black text, and nondefault
settings are highlighted as bold blue text. This helps makemodified fields more
obvious.

• In menu lists, the factory default settings are highlighted in bold text, and
nondefault values are in regular black text.
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HeartStart Configure also turns fields on and off based on other settings you select.
If a field has gray wavy lines through it, it depends on another field and cannot be
changed until that related field is modified.

To modify a configuration

You can set all fields to original factory default settings by clicking Restore
Defaults .

1. Click the Configurations navigation button to display the Configurations
workspace.

2. (Optional) If you do not have a configuration tomodify, then in Configuration
Tasks, click the defibrillator and guideline link to create a new configuration.

3. (Optional) Type ameaningful name and description in the Configuration Name
and Configuration Description fields.

The new information replaces the selection.

4. Select the parameter that you want to change.

A menu list appears.

5. In the openmenu list, click a setting.

6. (Optional)When you are satisfied with your changes, on the File menu or

toolbar, click Save .

Using Click Mode

To prevent unintentional setting selections, use Click Mode. This is the default
selectionmode for mouse operation. Click Modemeans that youmust first click a
field to see themenu of available settings, and then click themenu list to select a
setting. Themenu list disappears when you click away from the field.

If you uncheck Click mode (by clicking Tools, thenOptions), you can hover the
cursor over a field to display themenu list (without needing to click), and then click
an item in the list to change a setting.

Restoring Default Configuration Settings
UseRestore Defaults when you want to reset the configuration to the original
factory settings.

The following are reasons to restore default settings:
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• You havemodified settings in an open configuration, you don't like what you
have done, and now you want to restore the configuration to the default
settings.

• You want to retrieve a defibrillator configuration, restore the default settings,
and then send the factory settings to the defibrillator.

To restore default configuration settings

1. Display the configuration in the Configurations workspace.

2. From the Edit menu or toolbar, click Restore Defaults .

Saving Your Work
To save your configuration

1. Display your configuration in the Configurations workspace.

2. From the File menu or toolbar, click Save to save your configuration.

HeartStart Configure saves your configuration changes to an internal file.

Deleting Configurations
You can delete a configuration only from the Configurations workspace. If you want
to export a configuration before deleting it, see Exporting a Configuration File on
page.69.

Once you delete a configuration, you cannot restore it or undo your delete. All of
the configuration information will be lost.

To delete a configuration

1. Click the Configurations navigation button to display the Configurations
navigation pane and workspace.

2. Click All Configurations to display a list of configurations in the Configurations
workspace.

3. Click the configuration that you want to delete.

4. On the File menu or toolbar, click Delete .

5. At the prompt, click Yes.
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Transferring Configurations
Use the TransferWizard to update your defibrillator configuration.

The TransferWizard consists of the following wizard pages:

• A Welcome page where you can learn about the wizard. You can choose to
bypass this page in the future.

• A Select Defibrillator Page that displays the defibrillator's connection state,
serial number, connection, andmodel. HeartStart Configure scans to locate the
defibrillator. You can select the defibrillator that you want to configure, and then
complete your tasks using the wizard.

When you click Configurations, and then click Retrieve , the wizard displays
theWelcome page. Click Next to open the Select Defibrillator Page.

The following table describes the information on the Select Defibrillator page.

Data
Column Details

Connection
State

Whether or not the defibrillator is ready. Possible values are:

Ready: the defibrillator is compatible with the information type being
transferred.

Offline: the defibrillator was found in a previous scan but not included
in the most recent defibrillator scan.

Incompatible: the defibrillator is ready but cannot receive the
information type being transferred.

Serial
Number

The defibrillator's serial number found in the scan

Connection The type of defibrillator transfer method used

Model The defibrillator model

• A Processing page indicates that the computer is connecting to the
defibrillator.

• A Status page indicates either success or failure for the operation.

To use the TransferWizard to send a configuration, see the following topics:

HeartStart FR3 defibrillators
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• To send a HeartStart FR3 defibrillator configuration, see Sending a
HeartStart FR3Configuration on page.40.

HeartStart FRx defibrillators

• To send a HeartStart FRx configuration, see Sending a HeartStart FRx
Configuration on page.52.

HeartStart HS1 defibrillators

• To send a HeartStart HS1 configuration, see Sending a HeartStart HS1
Configuration on page.58.

Importing a Configuration File
You can import a configuration file to the Configurations workspace that was
created on a colleague's computer and that is presently in a folder accessible from
your computer. Youmight want to do this for these reasons:

• You want to import the configuration that your colleague or medical director
created to configure your HeartStart defibrillators.

• You want to import a configuration that was exported as amaster
configuration.

After you import a file, HeartStart Configure displays the configuration file in the
Configurations workspace. You can then view andmodify the configuration.

To import a file

1. Click the Configurations navigation button.

2. On the File menu or toolbar, click File, and then click Import .

HeartStart Configure displays the Import File window. The Import File window
displays the last folder that you used to import a file. If the file is in a different
location, select the appropriate folder in the Import File window to navigate to the
file location. The default import folder is located in theMy Documents folder.

3. Click the File of Type down arrow to select either an XML file or DAT file.

4. Select the configuration file, and then click Open.

HeartStart Configure displays the imported configuration file.

8 -Working with Configurations



69

Exporting a Configuration File
You can export a configuration file that you created on the Configurations
workspace for use by a colleague on another computer that runs HeartStart
Configure.

Here are a few reasons to export a configuration file to another computer:

• You want to give a configuration file you created to your colleagues so that they
can standardize their defibrillator settings.

• You want to export your saved configurations for safekeeping.

To export a file

1. Click the Configurations button to open the Configurations workspace.

2. In the navigation pane on the Saved Configurations pane, click All
Configurations.

3. Click the configuration to export.

4. From the File menu or toolbar, click Export .
The Export File As window shows the last folder you used to export a file.

To use a different location, navigate to the directory of your choice.

5. (Optional) Rename the file, and then click Save.

The configuration file is exported to the selected folder.

Displaying Information
On both the Configurations and Administration workspaces, you can categorize,
sort, and group the information in tables by column headers (for example,
Description). This helps youmanage large amounts of information, and lets you
easily navigate to a single item in an information group.

Working with Columns
You can customize the columns that appear on the table.

To change or size a column width

• Click and hold the column border, and then drag the border to the size you prefer.
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To reset a column to its previous width

• Click the column border, and then double-click the border.

To hide or display a column

1. Right-click the column header name to display a shortcut menu.

A popupmenu appears.

2. Click a check box for each column that you want to hide or display on the table.

Column headers with a check mark display on the table.

To move a column

• Click and hold the column header, and then drag it left or right to a new location.

Sorting Information in a Column
You can sort information in a column by clicking the column header. HeartStart
Configure displays a triangular symbol (arrow) in the column header to indicate the
sort order.

To sort column entries

• Click the column header to sort the list of information in ascending ( 1 to 9,
or a to z) or descending (9 to 1, or z to a) order.

Grouping Information in Columns
In the gray area above information such as configurations or System Logmessages,
you can set up groups using table column headers. Setting up groups has the effect
of sorting the information into major andminor sorts. For example, you can group
information in the System Log using the column, Type. This creates an additional
sort of the table according to the values in the Type column: Information and Error. If
you want to create further minor sorts, you can then dragmore column headings into
the gray area to create subgroups.

You can also hide or display (collapse or expand) the grouped information.
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To group information

1. Click a column header and drag it to the grouping area labeled Drag a header
here to group by that column.

The column namemoves to the grouping area, and the table displays the groups
you create.

2. Repeat step 1 as necessary to createmore groups.

HeartStart Configure creates the next group level.

Click the column header to sort the order in which the grouped information
appears.

To hide or display information groups

1. Locate the group of rows to collapse.

2. Click the Collapse button to the left of the group to collapse it, or click the
Expand button to the left of the group to expand it.

• If you want to hidemultiple information groups, on the View menu or toolbar,
click Collapse All .

• If you want to display multiple information groups, on the View menu or
toolbar, click Expand all .

To ungroup information

• Click a column header (for example, Type) in the grouping area and drag it below
the table header.
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Working with the System Log
The System Log displays HeartStart Configure activity. In the navigation pane, click
Administration to access the System Log.

Two information types are available in the System Log: Information and Error
messages.

• An Information message summarizes end-user actions. For example, a
message stating "Opened the application" is created when you open Philips
HeartStart Configure.

• An Error message specifies what an error is or why it occurred. For example, if
there is a failure to import a file, an error message states "Failed to import file"
and includes the file path in parentheses. For a table of systemmessages, see
System LogMessages on page.115.

You can email the HeartStart Configure System Log information to Philips Customer
Support when you are asked to do so. On the Helpmenu, click Email Customer
Support.

Opening the System Log
The System Log is available from the Administration navigation pane. On the
navigation pane, click Administration to open the System Log. HeartStart Configure
displays the System Log workspace.

Viewing the System Log
The System Log displays the status of all Philips HeartStart Configure activity. It
also contains all messages that are generated by HeartStart Configure about actions
and events in the software.
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You can view the following System Log columns in the System Log workspace. An
asterisk (*) represents default columns.

• Type*

• Date and Time*

• Action*

• Description*

• User Name* (This is the name of the user who is currently logged in, not the
name that appears in the Name field in the Configurations workspace.)

• Computer

• Serial Number

• Configuration Name

• Model

• Transfer Method

To view additional columns, right-click the column header, and click the column that
you want to appear.

You can sort, group, and customize columns in the System Log just as you can
in the Configurations and Administration workspaces. For more information,
see Displaying Information on page.69.

For a list of the types of System Logmessages, see System LogMessages on
page.115.

For each action in the System Log, the software includes the following information:

• The type of activity; for example, Information or Error

• The action that occurred

• A description of the action

• The date and time when the action occurred

9 -Working with the System Log
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Understanding Confirmation
Messages

A confirmationmessage does one of two things:

• Informs you that an actionmight result in a change to a configuration

• Warns you that an actionmay cause a permanent change.

By default, confirmationmessages are enabled.

To disable confirmation messages

• Click the Do not show this message again checkbox when a confirmation
message appears.

To re-enable confirmation messages

• On the Tools menu, click Options, and then click Restore Confirmations.
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Contacting Customer
Support

Philips strives to provide you with excellent customer service and technical support.
Software updates are available from the Helpmenu. From the Helpmenu, click
Check for Updates.

You can contact Customer Support through email, the Internet, telephone, and
mailing address, or via the Getting Started page.

• Send email to hsconfigure.support@philips.com

• Visit the Philips Healthcare product support Web site at:

http://www.healthcare.philips.com/main/products/
resuscitation/products/data_management/index.wpd

To view the Philips Healthcare Product support Web site better in the
online help pane, double-click the top of the help window to expand the
pane.

For telephone assistance outside the United States, please call your sales
representative or local sales office. Use the technical support telephone numbers for
datamanagement products on the product support Web site.

For telephone support in English only, call the following numbers between 8:00 AM
and 4:00 PM, Pacific Time:

• 1 (800) 263-3342, inside the United States

• +1 (206) 664-7745, outside the United States

77

mailto:hsconfigure.support@philips.com?subject=HeartStart Configure Support
http://www.healthcare.philips.com/main/products/resuscitation/products/data_management/index.wpd
http://www.healthcare.philips.com/main/products/resuscitation/products/data_management/index.wpd
http://www.healthcare.philips.com/main/products/resuscitation/products/data_management/index.wpd


78

Region Address Telephone Number

United States Philips Healthcare

3000 Minuteman Road

Andover, Massachusetts,

01810-1099

(800) 263-3342

Canada Philips Medical Systems, a
division of Philips Electronics
Ltd.

281 Hillmount Road

Markham, Ontario,

L6C 2S3 Canada

(800) 291-6743

Europe, Middle
East, and Africa

Philips Medizinsysteme
Boeblingen GmbH, Cardiac and
Monitoring Systems

Hewlett-Packard Strasse 2

71034 Boeblingen, Germany

(+49) 7031 463-2254

Latin America Philips Medical Systems

Rua Verbo Divino - 1400 7o
Andar

04719-002 –Sao Paulo, Brazil

(+55) 0800 701 7789

Asia Pacific Philips Electronics Hong Kong
Ltd.
6/F, Core Building 1

1 Science Park East Avenue

Hong Kong Science Park

Shatin. New Territories, Hong
Kong

(+852) 2821 5888

A - Contacting Customer Support
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Getting Help
Customer Support can assist you in resolving issues with HeartStart Configure
software.

You can also email the HeartStart Configure System Log information to Customer
Support when you are asked to do so. On the Helpmenu, click Email Customer
Support.

Customer Support technicians provide help for the following:

• Explaining the proper use of application features and answering your questions
about how the application works

• Explaining the proper installation andmaintenance of Philips HeartStart
Configure

• Assisting you in selecting and configuring card readers

• Assisting you in setting up an IrDA connection or in placing a defibrillator in
Administrationmode

Customer support technicians do not provide help for the following:

• Interpreting ECG ormedical data. Please call your medical director or clinical
specialist.

• Repairing hardware. Support technicians can help you determine if you have a
hardware problem, but they cannot help you fix problems that are not related to
Philips HeartStart Configure software.

• Troubleshooting defibrillators. Please call Philips Customer Support and ask for
defibrillator support.

• Troubleshooting non-Philips products.

Helping Us Help You
You can help our technicians give you better support by doing the following:

• Calling from a phone near your computer

• Having the application started and running

• Having the following information available. This information is available by
clicking the Help menu, and then clicking About:

• Product information, including themodel number
• Serial number
• Software revision or version

A - Contacting Customer Support
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• Knowing the version of Windows that you are using

• Knowing the software's installed options (if applicable)

• Having a written copy of the error message text

• Recording details about the activity and task you were doing when the error
occurred

A - Contacting Customer Support



B

Configuration Parameter
Field Descriptions

Use the configuration parameter field description tables when you change
configuration fields on your HeartStart defibrillator. These tables define the
parameter settings, and show both the default and nondefault settings.

It is the responsibility of themedical supervisor to interpret a parameter and select
the correct setting based on your institution's requirements.

You shouldmake changes only under the direction of amedical supervisor.
Changing settings changes the way the defibrillator operates in an emergency.
Sincemany patient-care protocol parameters interact with each other, it is
important to understand how each parameter affects the protocol.

The American Heart Association (AHA), European Resuscitation Council, and
International Liaison Committee on Resuscitation (ILCOR) periodically publish
guidelines that advise on best practices for resuscitation. When the guidelines are
published, Philips updates the programming of its defibrillators accordingly.

Hence, for a given defibrillator model, users may have defibrillators programmed to
observe different guidelines. When configuring your device, youmust select the
devicemodel and the correct guidelines. Use the guidelines that the defibrillator is
actually programmed to observe, not the guidelines that you think you would like it to
observe.
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FR3 Configuration Parameters
The HeartStart FR3 is shipped with a factory-default setup optimized for compliance
with Guidelines 2010. This is designed tomeet the needs of most users. You can
also configure the FR3 extensively.

This topic describes the HeartStart FR3 configuration parameters. For more
information on how to implement FR3 parameters for specific uses, see the
HeartStart FR3Defibrillator Instructions for Administrators guide.

When HeartStart Configure retrieves a configuration, the firmware version for the
defibrillator appears in the title bar for the workspace.

Default field settings in themenus appear in bold black typeface. Nondefault
settings in the workspace appear in blue typeface.

Overview group

Configuration name

Displays the name of the configuration.

You can change the assigned name.

Configuration description

Displays the description of the configuration.

You can change the description by typing details in the box.

Date modified

Displays the date and time at which the configuration was created or last
updated.

User name

Displays the user name of the user whomodified the configuration.

You can type a unique user name.

Device group

The device operation parameter settings determine the basic behavior of HeartStart
FR3, irrespective of individual protocols.

Volume

Sets the FR3 speaker volume.

FR3Configuration Parameters
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The allowable settings are:

Loud (the default setting)

Medium

Soft

ECG display

(FR3 ECGmodel 861389 only)

Enables (ON) or disables (OFF) display of the patient’s ECG on the FR3 screen.

The allowable settings are:

On (the default setting)

Off

Record audio

Enables (ON) or disables (OFF) audio recording on the data card during use.

The allowable settings are:

On

Off (the default setting)

Wireless PIN

Sets the Bluetooth personal identification number (PIN). Required only for use
with the optional Bluetooth wireless transceiver module [REF: 989803150081].

You can change the Bluetooth PIN only through HeartStart Configure.

For security reasons, the PIN is not displayed on the FR3 screen.

In the View Setup feature in Administrationmode, the PIN is shown as “Default”
if it has never been changed, or “****” if it has been changed using HeartStart
Configure.

The allowable settings are:

Enter a 4-digit number.

2071 (the default setting)

Defibrillation

These parameters govern the number of and time between defibrillation shocks in a
shock series.

Shock series

(Number of shocks per stack)

FR3Configuration Parameters



84

Sets the number of shocks in a series that must be delivered before the FR3
automatically activates a Basic CPR Interval.

A new shock series begins when a shock is delivered in any of the following
circumstances:

• After the FR3 is turned on
• After a completion of any CPR protocol
• When the Shock series setting is greater than 1 and if the time since the

previous shock exceeds the shock series interval setting (when the shock
series setting is greater than 1)

The allowable settings are:

1 (the default setting)

2

3

4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted
as part of the current shock series. This parameter applies only when the Shock
series setting is greater than 1. The time interval is in minutes.

If you click Infinite, then the shock protocol will not time out until the configured
number of shocks per stack (shock series) has been delivered.

The allowable settings are:

1 (the default setting)

2

Infinite

Advanced mode use

Enables (ANALYZE and CHARGE) or disables (OFF) advancedmode.

ANALYZE – The FR3 permits user-initiated rhythm analysis when the FR3
entered the advancedmode.

CHARGE – The FR3 permits user-initiated rhythm analysis, and charge and
disarm when the advancedmode is entered.

For more information, see the AdvancedMode appendix in the FR3Defibrillator
Instructions for Administrators guide.

The allowable settings are:

Analyze

Charge (available only for the FR3 ECGmodel)

FR3Configuration Parameters
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Off (the default setting)

Advanced use prompt repeat rate

Sets the repeat rate for patient care prompts provided by HeartStart FR3when
Advanced mode use is configured to ANALYZE or CHARGE. The repeat rate
is in minutes.

For more information, see the AdvancedMode appendix in the FR3Defibrillator
Instructions for Administrators guide.

The allowable settings are:

.5 (the default setting)

1.0

2.0

Self-test group

The periodic self-tests (PST) conducted by HeartStart FR3 can be configured to test
for certain preconnected accessories. Although the default setting is OFF,
HeartStart FR3 automatically tests any accessory connected to it during periodic
self-tests. However, if self-test for an accessory is configured to ON and HeartStart
FR3 does not detect the accessory, it provides alert chirps.

Test pads

Enables (ON) or disables (OFF) testing for the presence of preconnected pads
during each self-test.

The allowable settings are:

On

Off (the default setting)

Test data card

Enables (ON) or disables (OFF) testing for the presence of an installed data card
during each self-test.

The allowable settings are:

On

Off (the default setting)

FR3Configuration Parameters
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General CPR group

General CPR parameters apply to all CPR protocols. The FR3 provides three kinds
of separately configurable CPR protocols. The kind of CPR protocol applied
depends on its context in the patient care cycle.

Basic CPR — Upon completion of a shock series (FR3 default shock series is one
shock), HeartStart FR3 provides a CPR protocol.

CPR First — HeartStart FR3 provides a CPR protocol before defibrillation therapy,
based on the selected SMART CPR algorithm or the User setting.

NSA CPR — After a no-shock-advised (NSA) decision, HeartStart FR3 provides an
attend-to-patient period with a CPR option button or, if NSA CPR is configured ON,
an NSA CPR protocol.

Each of these three protocol types can also be configured separately for adult and
infant/child applications, for a total of six distinct CPR protocols.

Unless otherwise noted, these parameters pertain to all adult and infant/child CPR
protocols (Basic CPR, CPR First, and NSA CPR) initiated by the FR3. If you
change a general CPR parameter setting, it will be applied to every CPR protocol.

CPR protocols are time-based, using the selected CPR duration setting.

Metronome

Enables (ON) and disables (OFF) audio beats for CPR compressions.

Metronome audio beats, if enabled, will mask ambient sounds during CPR
in the Record Audio data.

The allowable settings are:

On

Off (This is the default setting.)

CPR First

Sets whether the FR3 provides an interval for CPR prior to defibrillation, in the
first rhythm analysis in a device use.

The Analyze option button is always available in any CPR First protocol.
Press the designated option button to initiate FR3 analysis of heart rhythm.

FR3Configuration Parameters
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The allowable settings are:

Off (This is the default setting.) – The FR3 never provides an initial CPR
interval before rhythm analysis.

SMART CPR auto1 – The FR3 uses amore conservative rhythm analysis
system to determine if the presenting shockable heart rhythm is
characteristic of long downtime (and therefore the patient should receive
CPR first). "Conservative" means that it is less likely to recommendCPR
first.

SMART CPR auto2 – The FR3 uses amore aggressive rhythm analysis
system to determine if the presenting shockable heart rhythm is
characteristic of long downtime (and therefore the patient should receive
CPR first). "Aggressive" means that it is more likely to recommendCPR
first.

User (User-initiated CPR Protocol) – The FR3 provides a protocol in which
responders can initiate the configured CPR protocol at any time by pressing
the CPR option button.

No Shock Advised (NSA) action

Sets FR3 behavior during the attend-to-patient period that follows any NSA (no-
shock-advised) decision. During this period, the responder can perform CPR or
otherwise attend to the patient, as needed.

Important: When configured to NSA CPR, the FR3 enables CPR Coaching for
use during the attend-to-patient period.

For more information on how to implement FR3NSA action parameters, see the
NSA Action appendix in the FR3Defibrillator Instructions for Administrators
guide.

When configured to NSA CPR, the FR3 enables configuration of NSA
CPR Coaching for use during the attend-to-patient period. NSA CPR
Coaching settings are ALWAYS and USER.

The allowable settings are:

NSA CPR (the default setting)

NSA Monitor

NSA CPR coaching

Sets the type of coaching during the attend-to-patient period when NSA action
is set to NSA CPR.

When configured to NSA CPR, this allows selection of NSA CPR Coaching
following an NSA decision, either at user discretion (USER) or ALWAYS.
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The allowable settings are:

Always (the default setting)

User

NSA Monitor prompt repeat rate

Sets the repeat rate for patient care prompts provided by the FR3 during
monitoring, only when NSA action is set to MONITOR. The repeat rate is in
minutes.

For more information, see the Configuration chapter and NSA Action appendix in
the FR3Defibrillator Instructions for Administrators guide.

The allowable settings are:

1.0 (the default setting)

2.0

3.0

Infinite – Select if you do not want to provide repeat prompting during
backgroundmonitoring.

CPR option button

Enables (ON) or disables (OFF) the ability to initiate a Basic CPR protocol by
pressing the designated option button, when active during rhythm analysis or a
shock related sequence, on the front panel of the FR3.

The allowable settings are:

On

Off (the default setting)

Analyze option button

Enables (ON) or disables (OFF) ability to interrupt a CPR protocol, NSA
monitoring, or attend-to-patient period and resume rhythm analysis, by pressing
the designated option button on the front panel of the FR3.

The allowable settings are:

On

Off (the default setting)

Protocol-specific CPR group

Specific CPR parameters apply to each CPR protocol individually. In other words,
each of these CPR Duration parameters can be configured separately for adult and
infant/child CPR protocols.

FR3Configuration Parameters
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Adult CPR First duration

Sets the length of the CPR protocol for Adult CPR First. The length of the
protocol is in minutes.

The allowable settings are:

1.0

1.5

2.0 (the default setting)

2.5

3.0

Adult Basic CPR duration

Sets the length of the CPR protocol for Adult Basic CPR. The length of the
protocol is in minutes.

The allowable settings are:

1.0

1.5

2.0 (the default setting)

2.5

3.0

Adult NSA CPR duration

Sets the attend-to-patient period for the Adult NSA CPR. The length of the
protocol is in minutes.

The allowable settings are:

1.0

1.5

2.0 (the default setting)

2.5

3.0

Infant/child CPR First duration

Sets the length of the CPR protocol for Infant/child CPR First. The length of the
protocol is in minutes.

The allowable settings are:

1.0

1.5

FR3Configuration Parameters
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2.0 (the default setting)

2.5

3.0

Infant/child Basic CPR duration

Sets the length of the CPR protocol for Infant/child Basic CPR . The length of
the protocol is in minutes.

The allowable settings are:

1.0

1.5

2.0 (the default setting)

2.5

3.0

Infant/child NSA CPR duration

Sets the length of the CPR protocol for Infant/child NSA CPR. The length of
the protocol is in minutes.

The allowable settings are:

1.0

1.5

2.0 (the default setting)

2.5

3.0

FR3Configuration Parameters
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FRx 2005 Configuration Parameters
This topic describes the configuration parameters for a HeartStart FRx programmed
to observe 2005 guidelines. For more information on how to implement FRx
parameters for specific uses, see the HeartStart FRx Owner's Manual.

When HeartStart Configure retrieves a configuration, the serial number for the
defibrillator appears in the title bar for the workspace.

Default field settings in themenus appear in bold black typeface. Nondefault
settings in the workspace appear in blue typeface.

Overview group

In the Overview, you can type a configuration identifier into text boxes for the
configuration. This view also indicates the last date and time that the configuration
was modified.

Configuration name

Displays the name of the configuration.

You can type a name to change the configuration name.

Configuration description

Displays the description of the configuration.

You can change the description by entering details into the text box.

Date modified

Displays the date and time that the configuration was created or last updated.

User Name

Displays the user name of the user whomodified the configuration.

You can type a unique user name.

Device group

The device operation parameter settings determine the basic behavior of the
HeartStart FRx, irrespective of individual protocols.

FRx 2005 Configuration Parameters
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Volume

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest. The
defibrillator uses the speaker for voice instructions and the charge-done tone.
The allowable settings are:

1

2

3

4

5

6

7

8 (the default setting)

Send ECG

Enables (ON) or disables (OFF) the ability to send ECG information (in real time)
from the defibrillator's infrared (IrDA) window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)

Off

AutoSend periodic self-test (PST)

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically
send periodic self-tests from the device's infrared (IrDA) window.

The allowable settings are:

On (the default setting)

Off

Defibrillation group

These parameters govern the number of and time between defibrillation shocks in a
shock series.

Shock Series

(Number of shocks per stack)

Sets the number of shocks in a series that must be delivered to start the
automatic protocol pause for patient assessment and CPR.
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During the protocol pause, the defibrillator does not perform rhythm analysis.

The protocol pause timer setting determines the length of the protocol pause
after the defibrillator completes a shock series.

The allowable settings are:

1 (the default setting)

2

3

4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted
as part of the current shock series. This parameter applies only when the Shock
series setting is greater than 1. The time interval is in minutes.

The allowable settings are:

1 (the default setting)

2

Infinite

CPR group

The following parameters determine how the HeartStart FRx orchestrates CPR
protocol.

No Shock Advised pause type

Sets the pause type following a No Shock Advised decision.

The allowable settings are:

Standard – The defibrillator does not perform rhythm analysis during the
pause. The pause time is determined by the selected protocol pause timer
and No Shock Advised pause timer settings.

SMART (the default setting) - The defibrillator conducts background
monitoring during the pause.

If the defibrillator detects a potentially shockable rhythm, the defibrillator
ends the SMART pause and resumes rhythm analysis (unless CPR or CPR
coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause is
converted to a standard NSA.
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No Shock Advised pause timer

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause
interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the
defibrillator overrides this setting and defines the length of the pause by the
protocol pause timer setting.

The allowable settings are:

0.5

1.0

1.5

2.0 (the default setting)

2.5

3.0

Protocol pause timer

Sets the length of the CPR pause interval. The two-minute CPR pause interval
automatically starts after the defibrillator completes voice instruction and a
shock series.

After the protocol pause, the defibrillator returns to automatic rhythm analysis.

The allowable settings are:

0.5

1.0

1.5

2.0 (the default setting)

2.5

3.0

CPR compression ratio

Sets the rate for CPR compression signals provided by the defibrillator. The
compression ratio is the number of compressions and breaths administered
during aminute.

Pauses begin and end with compressions.

The allowable settings are:

Adult = 30:2, Pediatric = 30:2 (the default setting)

Adult = 30:2, Pediatric = 15:2

Adult = 15:2, Pediatric = 15:2
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CPR adult ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for
adults while the defibrillator is in use.

• ChooseWith ventilation if responders provide ventilation when performing
CPR with adult pads.

• Choose No ventilation if coaching will be compressions-only when an adult
pads connector is installed.

The allowable settings are:

With ventilation (the default setting)

No ventilation

CPR infant/child ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for
children and infants while the defibrillator is in use.

• ChooseWith ventilation if responders provide ventilation when performing
CPR with an Infant/Child Key inserted.

• Choose No ventilation if coaching will be compressions-only when an
Infant/Child Key is inserted.

The allowable settings are:

With ventilation (the default setting)

No ventilation

Voice Prompts group

Determines the timing and content of key protocol voice instructions.

Call EMS voice instruction

Sets the point during the response (at the start of the first patient care pause)
 when the defibrillator plays the voice instruction to call emergency medical
services.

The allowable settings are:

At power on

At power on and at the start of the first pause interval

At the start of the first pause interval (the default setting)

No reminder

CPR prompt

Sets the CPR reminder voice prompts.

FRx 2005 Configuration Parameters



96

The allowable settings are:

CPR 1: Begin CPR.

CPR 2: It is safe to touch the patient. Begin CPR.

CPR 3: Begin CPR. For help with CPR, press the flashing blue button.

CPR 4 (the default setting): It is safe to touch the patient. Begin CPR. For
help with CPR, press the flashing blue button.

FRx 2005 Configuration Parameters
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FRx 2000 Configuration Parameters
This topic describes the configuration parameters for a HeartStart FRx defibrillator
programmed to observe the 2000 guidelines. For more information on how to set your
HeartStart FRx parameters for specific uses, see the HeartStart FRx Defibrillator
Owner's Manual, Edition 5.

When HeartStart Configure retrieves a configuration, the serial number for the
defibrillator appears in the title bar for the workspace.

Default field settings in themenus appear in bold black typeface. Nondefault
settings in the workspace appear in blue typeface.

Overview group

In the Overview, you can type your own configuration identifier information into
boxes for the configuration. This display also indicates the last date and time that the
configuration was modified.

Configuration name

The name of the configuration.

You can change the assigned name.

Configuration description

The description of the configuration.

You can change the description by typing details into the box.

Date modified

The date and time that the configuration was created or last updated.

User Name

The user name of the user whomodified the configuration.

You can type a unique user name.

Device group

The device operation parameter settings determine the basic behavior of the
HeartStart FRx, irrespective of individual protocols.

FRx 2000 Configuration Parameters



98

Volume

Sets the volECG outume of the defibrillator speaker. 1 is lowest; 8 is highest.

The defibrillator uses the speaker for voice instructions and the charge-done
tone.

The allowable settings are:

1

2

3

4

5

6

7

8 (the default setting)

Send ECG

Enables (ON) or disables (OFF) the ability to send ECG information (in real time)
from the defibrillator infrared (IrDA) window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)

Off

AutoSend periodic self-test (PST)

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically
send periodic self-tests from the defibrillator infrared (IrDA) window.

The allowable settings are:

On (the default setting)

Off

Defibrillation group

These parameters govern the number of and time between defibrillation shocks
in a shock series.

Shock Series

(Number of shocks per stack)
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Sets the number of shocks in a series that must be delivered to start the
automatic protocol pause for patient assessment and CPR.

During the protocol pause, the defibrillator does not perform rhythm analysis.

The protocol pause timer setting determines the length of the protocol pause
after the defibrillator completes a shock series.

The allowable settings are:

1

2

3 (the default setting)

4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted
as part of the current shock series. This parameter applies only when the shock
series setting is greater than 1. The time interval is in minutes.

The allowable settings are:

1 (the default setting)

2

Infinite

CPR group

The following parameters determine how HeartStart FRx orchestrates the CPR
protocol.

No Shock Advised pause type

Sets the type of pause following a No Shock Advised decision.

The allowable settings are:

Standard – The defibrillator does not perform rhythm analysis during the
pause. The pause time is determined by the selected protocol pause timer
and No Shock Advised pause timer settings.

SMART (the default setting): The defibrillator conducts background
monitoring during the pause. If the defibrillator detects a potentially
shockable rhythm, the defibrillator ends the SMART pause and resumes
rhythm analysis (unless CPR or CPR coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause is
converted to a standard NSA pause.
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No Shock Advised pause timer

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause
interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the
defibrillator overrides this setting and defines the length of the pause by the
protocol pause timer setting.

The allowable settings are:

0.5

1.0 (the default setting)

1.5

2.0

2.5

3.0

Protocol pause timer

Sets the length of the CPR pause interval. The CPR pause interval starts after
the defibrillator completes voice instruction and a shock series. After the
protocol pause, the defibrillator returns to automatic rhythm analysis. The pause
interval is in minutes.

The allowable settings are:

0.5

1.0 (the default setting)

1.5

2.0

2.5

3.0

CPR prompt rate

Sets the rate for CPR compression signals provided by the defibrillator. The
compression rate is the number of compressions administered during aminute.

The allowable settings are:

80

100 (the default setting)

CPR adult ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for
adults while the defibrillator is in use.
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• ChooseWith ventilation if responders provide ventilation when performing
CPR with adult pads.

• Choose No ventilation if coaching will be compressions-only when an adult
pads connector is installed.

The allowable settings are:

With ventilation (the default setting)

No ventilation

CPR infant/child ventilation
Specifies that the responders use ventilation prompts at the ventilation ratio for
children and infants while the defibrillator is in use.
• ChooseWith ventilation >if responders provide ventilation when

performing CPR with an Infant/Child Key inserted.
• Choose No ventilation if coaching will be compressions-only when an

Infant/Child Key is inserted.
The allowable settings are:

With ventilation  (the default setting)

No ventilation

Voice Prompts group

Determines the timing and content of key protocol voice instructions.

Call EMS voice instruction

Sets the point when the defibrillator plays the voice instruction to call emergency
medical services.

The allowable settings are:

At power on

At power on and at the start of the first pause interval

At the start of the first pause interval (the default setting)

No reminder

CPR prompt

Sets the CPR reminder voice prompts.

The allowable settings are:

CPR 1: If needed, begin CPR.

CPR 2: Check airway, breathing, circulation. If needed, begin CPR.

CPR 3: If needed, begin CPR. Press the blue button for CPR coaching.

CPR 4 (the default setting): Check airway, breathing, circulation. If needed,
begin CPR. Press the blue button for CPR coaching.
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HS1 2005 Configuration Parameters
This topic describes the configuration parameters for the HeartStart HS1 that is
programmed to observe 2005 guidelines. For detailed discussions on how to
implement HS1 parameters for specific uses, see the HeartStart HS1Defibrillator
Owner's Manual.

When HeartStart Configure retrieves a configuration, the defibrillator serial number
appears in the title bar for the workspace.

Default field settings in themenus appear in bold black typeface. Nondefault
settings in the workspace appear in blue typeface.

Overview group

In the Overview, you can type a configuration identifier into boxes for the
configuration. This area also indicates the last date and time that the configuration
was modified.

Configuration name

Displays the name of the configuration.

You can change the assigned name.

Configuration description

Displays the description of the configuration.

You can change the description by typing details in the box.

Date modified

Displays the date and time when the configuration was created or last updated.

User Name

Displays the user name of the user whomodified the configuration.

You can type a unique user name.

Device group

The device operation parameter settings determine the basic behavior of the
HeartStart HS1, irrespective of individual protocols.

Volume

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest.
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The defibrillator uses the speaker for voice instructions and the charge-done
tone.

The allowable settings are:

1

2

3

4

5

6

7

8 (the default setting)

Send ECG

Enables (ON) or disables (OFF) the ability to send ECG information (in real time)
from the defibrillator infrared (IrDA) window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)

Off

AutoSend periodic self-test (PST)

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically
send periodic self-tests from the device's infrared (IrDA) window.

The allowable settings are:

On (the default setting)

Off

Defibrillation group

These parameters govern the number of and time between defibrillation shocks in a
shock series.

Shock Series

(Number of shocks per stack)

Sets the number of shocks in a series that must be delivered to start the
automatic protocol pause for patient assessment and CPR.

During the protocol pause, the defibrillator does not perform rhythm analysis.
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The protocol pause timer setting determines the length of the protocol pause
after the defibrillator completes a shock series.

The allowable settings are:

1 (the default setting)

2

3

4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted
as part of the current shock series.

This parameter applies only when the Shock series setting is greater than 1.
The interval is in minutes.

The allowable settings are:

1 (the default setting)

2

Infinite

CPR group

These parameters determine how HeartStart HS1 orchestrates the CPR protocol.

No Shock Advised pause type

Sets the type of pause following a No Shock Advised decision.

The allowable settings are:

Standard: The defibrillator does not perform rhythm analysis during the
pause. The pause time is determined by the selected protocol pause timer
and No Shock Advised pause timer settings.

SMART (the default setting): The defibrillator conducts background
monitoring during the pause. If the defibrillator detects a potentially
shockable rhythm, the defibrillator ends the SMART pause and resumes
rhythm analysis (unless CPR or CPR coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause converts
to a standard NSA pause.
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No Shock Advised pause timer

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause
interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the
defibrillator overrides this setting and defines the length of the pause by the
protocol pause timer setting.

The allowable settings are:

0.5

1.0

1.5

2.0 (the default setting)

2.5

3.0

Protocol pause timer

Sets the length of the CPR pause interval. The CPR pause interval starts after
the defibrillator completes voice instruction and a shock series. After the
protocol pause, the defibrillator returns to automatic rhythm analysis. The pause
interval is in minutes.

The allowable settings are:

0.5

1.0

1.5

2.0 (the default setting)

2.5

3.0

CPR compression ratio

Sets the rate for CPR compression signals provided by the defibrillator. The
compression ratio is the number of compressions and breaths administered
during aminute.

Pauses begin and end with compressions.

The allowable settings are:

Adult = 30:2, Pediatric = 30:2 (the default setting)

Adult = 30:2, Pediatric = 15:2

Adult = 15:2, Pediatric = 15:2

HS1 2005 Configuration Parameters



106

CPR adult ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for
adults while the defibrillator is in use.

• ChooseWith ventilation if responders provide ventilation when performing
CPR with adult pads.

• Choose No ventilation if coaching will be compressions-only when an adult
pads connector is installed.

The allowable settings are:

With ventilation (the default setting)

No ventilation

CPR infant/child ventilation

Specifies that the responders use ventilation prompts at the ventilation ratio for
children and infants while the defibrillator is in use.

• ChooseWith ventilation if responders provide ventilation when performing
CPR with infant/child pads connected.

• Choose No ventilation if coaching will be compressions-only when an
infant/child pads connector is installed.

The allowable settings are:

With ventilation (the default setting)

No ventilation

Voice Prompts group

Determines the timing and content of key protocol voice instructions.

Call EMS voice instruction

Sets the point at which the defibrillator plays the voice instruction to call
emergency medical services.

The allowable settings are:

At power on

At power on and at the start of the first pause interval

At the start of the first pause interval (the default setting)

No reminder

CPR prompt

Sets the CPR reminder voice prompts.
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The allowable settings are:

CPR 1: Begin CPR.

CPR 2: It is safe to touch the patient. Begin CPR.

CPR 3: Begin CPR. For help with CPR, press flashing blue button.

CPR 4 (the default setting): It is safe to touch the patient. Begin CPR. For
help with CPR, press the flashing blue button.
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HS1 2000 Configuration Parameters
This topic describes the configuration parameters for the HeartStart HS1 defibrillator
programmed to observe the 2000 guidelines. For more information on how to set
HeartStart HS1 parameters for specific uses, see the HeartStart HS1Defibrillator
Owner's Manual.

When HeartStart Configure retrieves a configuration, the defibrillator serial number
appears in the title bar for the workspace.

Default field settings in themenus appear in bold black typeface. Nondefault
settings in the workspace appear in blue typeface.

Overview group

In the Overview, you can type your own configuration identifier information into text
boxes. This area also indicates the last date and time that the configuration was
modified.

Configuration name

Displays the name of the configuration.

You can change the assigned name.

Configuration description

Displays the description of the configuration.

You can change the description by typing details in the box.

Date modified

Displays the date and time that the configuration was created or last updated.

User Name

Displays the user name of the user whomodified the configuration.

You can type a unique user name.

Device group

The device operation parameter settings determine the basic behavior of
HeartStart HS1, irrespective of individual protocols.
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Volume

Sets the volume of the defibrillator speaker. 1 is lowest; 8 is highest. The
defibrillator uses the speaker for voice instructions and the charge-done tone.

The allowable settings are:

1

2

3

4

5

6

7

8 (the default setting)

Send ECG

Enables (ON) or disables (OFF) the ability to send ECG information (in real time)
from the defibrillator IrDA window.

Also known as "ECG out."

The allowable settings are:

On (the default setting)

Off

AutoSend periodic self-test (PST)

Enables (ON) or disables (OFF) the ability of the defibrillator to automatically
send periodic self-tests from the defibrillator's infrared (IrDA) window.

The allowable settings are:

On (the default setting)

Off

Defibrillation group

These parameters govern the number of and time between defibrillation shocks
in a shock series.

Shock series

(Number of shocks per stack)
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Sets the number of shocks in a series that must be delivered to start the
automatic protocol pause for patient assessment and CPR.

During the protocol pause, the defibrillator does not perform rhythm analysis.

The protocol pause timer setting determines the length of the protocol pause
after the defibrillator completes a shock series.

The allowable settings are:

1

2

3 (the default setting)

4

Shock Series Interval

Sets the time interval used to determine if a delivered shock should be counted
as part of the current shock series. This parameter applies only when the Shock
series setting is greater than 1. The interval is in minutes.

The allowable settings are:

1 (the default setting)

2

Infinite

CPR group

These parameters determine how the HeartStart HS1 orchestrates the CPR
protocol.

No Shock Advised pause type

Sets the type of pause following a No Shock Advised decision.

The allowable settings are:

Standard: The defibrillator does not perform rhythm analysis during the
pause. The pause time is determined by the selected protocol pause timer
and No Shock Advised pause timer settings.

SMART (the default setting): The defibrillator conducts background
monitoring during the pause. If the defibrillator detects a potentially
shockable rhythm, the defibrillator ends the SMART pause and resumes
rhythm analysis (unless CPR or CPR coaching is being performed).

If CPR or CPR coaching is being performed, the SMART NSA pause converts
to a standard NSA pause.
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No Shock Advised pause timer

Sets the length of the No Shock Advised (NSA) pause interval. The NSA pause
interval starts after an NSA decision. The pause interval is in minutes.

If the defibrillator delivers a shock within the shock series interval, the
defibrillator overrides this setting and defines the length of the pause by the
protocol pause timer setting.

The allowable settings are:

0.5

1.0 (the default setting)

1.5

2.0

2.5

3.0

Protocol pause timer

Sets the length of the CPR pause interval. The CPR pause interval starts after
the defibrillator completes voice instruction and a shock series.

After the protocol pause, the defibrillator returns to automatic rhythm analysis.
The pause interval is in minutes.

The allowable settings are:

0.5

1.0 (the default setting)

1.5

2.0

2.5

3.0

CPR prompt rate (compressions per minute)

Sets the rate for CPR compression signals provided by the defibrillator. The
compression ratio is the number of compressions administered during aminute.

The allowable settings are:

80

100 (the default setting)

Voice Prompts group

Determines the timing and content of key protocol voice instructions.
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Call EMS voice instruction

Sets the point when the defibrillator plays the voice instruction to call emergency
medical services.

The allowable settings are:

At power on

At power on and at the start of the first pause interval

At the start of the first pause interval (the default setting)

No reminder

CPR prompt

Sets the CPR reminder voice prompts.

The allowable settings are:

CPR 1: Check circulation. If needed, begin CPR.

CPR 2: Check airway. Check breathing. Check circulation. If needed, begin
CPR.

CPR 3: Check circulation. If needed, begin CPR. For help with CPR, press
the flashing blue button.

CPR 4 (the default setting): Check airway. Check breathing. Check
circulation. If needed, begin CPR. For help with CPR, press the flashing
blue button.
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Understanding Voice and
Screen Messages

All HeartStart defibrillators usemessages to ensure that you are aware of the
defibrillator's current status.

The HeartStart FRx and HeartStart HS1models use voicemessages, and the
HeartStart FR3model uses screen and voicemessages.

Following these announcements, you can place the defibrillator in Administration
mode and complete configuration tasks.

Defibrillator Voice and Screen Messages
The voicemessages are as follows:

• Insert pads cartridge (for HeartStart HS1)

• Plug in pads connector (for HeartStart FRx)

• Apply Pads. Plug in pads connector (for HeartStart FR3)
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System Log Messages
Use the System Log tomonitor HeartStart Configure system activity and to
troubleshoot problems. For more information, seeWorking with the System Log on
page.73.

There are two types of System Logmessages:

• Error messages describe incomplete actions.
• Information messages describe the actions that HeartStart Configure

completes successfully.

The following table identifies the type of message, themessage as it appears in the
action column, and a description or example of messages.

Examples are in parentheses.

System Log Messages

Type of
Message Action Description and Example

Error Export configuration Failed to export configuration

(Name = HS1,

Pathname = C:\Documents and
Settings\MyComputer\Desktop\

Configurations\HS12000.xml.)

Error Import configuration Failed to import file

(Pathname = C:\Documents and
Settings\MyComputer\Desktop\

Configurations\FRx2005.xml.)

Error Retrieve configuration Configuration retrieve failed:
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Type of
Message Action Description and Example

(Error = Failed to Retrieve Configuration)

Error Update application Failed in check for application updates

Error Update application Failed to update the application

Error Save configuration Updated the application

Error Send configuration Send failed:

(Model = FR3, Error = Configuration send failed)

Error Set the defibrillator
clock

Failed to set the defibrillator clock

(Model = FR3, Serial Number = C09B-00000)

Error Unexpected error The following exception occurred:

There is an unexpected exception.

Information Close application Closed the application

Information Delete configuration Deleted configuration

(Model = FR3, Name = New FR3 2005 configuration)

Information Export configuration Exported configuration

(Name = FR3, Pathname =

C:\Documents and

Settings\MyComputer\Desktop\

Configurations\FR32005.xml.)

Information Import configuration Imported configuration

(Pathname = C:\Documents and
Settings\MyComputer\Desktop\

Configurations\FR32005.xml.)

Information Open application Opened the application

Information Update application Updated the application
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Type of
Message Action Description and Example

Information Retrieve configuration Retrieved configuration from the defibrillator

(Model = FR3, Serial Number = C09B-00000)

Information Save configuration Created configuration

(Model = FR3, Name =

New FR3 2005 Configuration)

Information Send configuration Sent configuration to the defibrillator

(Model = FRx, Serial Number = 01234)

Information Set the defibrillator
clock

Set the defibrillator clock succeeded

(Model = FR3, Serial Number = C09B-00000)

D - System LogMessages
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Glossary
Administration

Administrationmode allows you to apply or change configuration settings in a
HeartStart supported defibrillator, and also allows an administrator to view
HeartStart Configure activities.

Administration mode

A setting on HeartStart defibrillators that allows the defibrillator to send and receive
information.

Administration pane

The Administration pane allows you to view system log entries for the computer
running HeartStart Configure.

AED

Stands for Automated External Defibrillator. A defibrillator that automatically
performs rhythm analysis of the patient’s surface electrocardiogram.

All Configurations

A feature in the Saved Configurations pane that allows you to view all configurations
that are available for viewing and editing in HeartStart Configure.

Archive

To store or save information.

Attend to Patient Period

A period following a no shock Advised (NSA) decision during which the responder
may perform CPR, if needed, or otherwise attend to the patient.

Bluetooth wireless transmission

Use of an optional FR3 Bluetooth wireless technology transceiver module to transfer
a configuration from aHeartStart FR3 defibrillator to a Bluetooth-enabled computer.
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Bluetooth®

A short-range wireless technology that uses radio links between a device such as
defibrillators and computers, mobile computers, mobile phones, and other portable
devices.

Bystander CPR

The attempt to perform basic CPR by someone who is not part of an organized
emergency response system. Typically, this person witnessed the arrest. In certain
situations, physicians, nurses, and paramedics may perform bystander CPR.

Card reader

Hardware that reads information from a data card.

CFG

Stands for configuration file. This binary file extension type is used for a HeartStart
FR3 configuration file.

Configuration

A file that sets the behavior of a defibrillator.

Configuration Tasks

A task pane in HeartStart Configure that allows you to create defibrillator
configurations per American Heart Association (AHA) guidelines, and set time, date,
and language options for the HeartStart FR3 defibrillator.

Configurations (feature)

A feature set that allows you to configure, manage, and review information about a
defibrillator configuration. HeartStart Configure identifies each configuration based
on the type, name and the date and time of the configuration. This allows you to list
configurations based on a variety of values.

Configurations pane

The Configurations pane allows you to view andmanage supported defibrillator
configurations.

CPR

Stands for Cardiopulmonary Resuscitation. A technique for providing artificial
respiration and heart compressions tomaintain life in a victim of Sudden Cardiac
Arrest (SCA).

Glossary



121

DAT

Stands for data file. This binary file format is used by Event Review 3.5 and Event
Review Pro 3.5 for HeartStart FRx and HS1 defibrillator configurations.

Data Card

A computer storage device used for recording and storing information. Some
HeartStart defibrillators use data cards to record configuration, ECG, and audio
information.

Defibrillator event

Information received from a defibrillator. Examples are alarms, shocks,
measurements, and error conditions.

Device

A generic term used for defibrillators and data cards.

ECG

Stands for electrocardiogram. The electrical rhythm of the heart as detected through
defibrillator pads.

EMS

Stands for Emergency Medical Services.

Error

Describes a system error or an erroneous input by the user.

Export

Saving a configuration as a file for use on another computer running HeartStart
Configure. This is typically done to share a configuration with other users or to back
up a configuration.

Feature

A link or button within the HeartStart Configure task pane that allows you to
complete a task.

Fibrillation

A disturbance of the normal heart rhythm that results in chaotic, disorganized
activity that cannot effectively pump blood. Ventricular fibrillation (fibrillation in the
lower chambers of the heart) is themost common cause of sudden cardiac arrest.
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FR3

A HeartStart compact, battery-powered automated external defibrillator (AED)
designed for use by trained responders to treat ventricular fibrillation (VF), themost
common cause of sudden cardiac arrest (SCA).

FRx

A HeartStart compact, battery-powered automated external defibrillator (AED)
designed for use by trained responders to treat ventricular fibrillation (VF), themost
common cause of sudden cardiac arrest (SCA).

Getting Started

A task pane in HeartStart Configure that allows you to navigate to online help,
selecting accessories, and check for software updates.

HS1

A HeartStart compact, battery-powered automated external defibrillator (AED) that
is designed for simple and reliable operation by minimally trained users to treat
ventricular fibrillation (VF), themost common cause of sudden cardiac arrest (SCA).

HTTP

Stands for Hypertext Transfer Protocol. The set of rules for exchanging files (text,
graphic images, sound, video, and other multimedia files) on theWorldWideWeb.

Import

Opening a defibrillator configuration file that is not stored in HeartStart Configure,
and was created by another user on another installation of HeartStart Configure.

Incident

The series of events involved in treating a patient with a defibrillator.

Information

Details action and events of an end-user using HeartStart Configure.

Language Card

A secure digital (SD) card that can be purchased separately for the HeartStart FR3
defibrillator model. It contains languages used by the local culture. You can either
change the primary language, or set a second language for bilingual operation.

License Manager

The LicenseManager allows you to type in your registration key to activate
HeartStart Configure software.
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Navigation pane

Use the navigation pane to navigate to workspaces and to select a defibrillator and
perform defibrillator configuration tasks.

NSA

Stands for no shock advised. A decision that is made by the defibrillator based on
analysis of the patient’s heart rhythm. The defibrillator will not deliver a shock in this
mode.

PST

For Periodic Self Test. A self-administered test mode that a HeartStart defibrillator
runs to ensure that all defibrillator components are functional and work properly. Test
results are Pass, Warning, or Call customer support.

Save

Adding a new configuration the information and its associated details to the
HeartStart Configure dataset for reuse later on other defibrillators in order to
standardize defibrillator behavior.

Saved configurations

The area of the Navigation pane where configurations can be viewed and filtered
based on supported defibrillator type.

Shock series

Also called shock stack. A sequence of one or more shocks, each separated by no
more than a preset interval. After completion of a shock series, the defibrillator
automatically provides a CPR protocol.

SMART analysis

The proprietary algorithm used by the FR3 to analyze the patient’s heart rhythm and
determine whether a shock is advised.

Smart CPR

A configurable feature that, either automatically or by manual selection, enables a
CPR interval before rhythm analysis and shock decision for patients with a
shockable rhythm.

System log

The system log lists all monitored application activity. Use the system log to review
application usage.

Task wizard

A software feature that guides the user through a task.
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URL

Stands for Uniform Resource Locator. An address for a resource on the Internet.
URLs are used by Web browsers to locate Internet resources. A URL specifies the
protocol to be used in accessing the resource (such as http: for aWorldWideWeb
page or ftp: for an FTP site), the name of the server on which the resource resides
(such as //www.whitehouse.gov), and, optionally, the path to a resource (such as an
HTML document or a file on that server).

Workspace

The pane to the right of the HeartStart Configure navigation pane. It displays the
active window for entering and viewing information.

XML

Stands for eXtensible Markup Language. This file format has a set of rules for
encoding documents in machine-readable form. It is used for HeartStart Configure
3.0 configuration files. A HeartStart Configure 3.0 file is exported in the XML file
format.
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Send ECG, field 92, 98, 103, 109

serial number 17-18

shock 91, 97, 102, 108

software updates, checking for 30, 77

software, activating and registering 17-18

sorting information in a column 70

starting Configure 16

status 67

system administrator 22

system log

Administration workspace 31

messages 115

opening the system log 73

viewing 73

working with the system log 73

system requirements 14

T

tables

appearance 70

technicians 22

telephone support 77

test data card 85

Timer, field 111

tips 9

title bar 28

toolbar 28

trademarks 2

transfer FR3 configuration SD card 41

transfer method selection page 67

transferring

configuration 53, 67

using a SD data card 37

U

uninstalling Configure 3.0 16

US Food andDrug Administration 21

user-initiated rhythm analysis 84

user guide

FR3 Instructions for Use 82

FRx Instructions for Use 91, 97

HS1 Instructions for Use 102, 108

user name 82, 91, 97, 102, 108

V

viewing a configuration 63

voice and screen messages 113

volume, field 82, 92, 98, 102, 109

W

wireless PIN 83

workspace 27, 29
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